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Chapter 1

Introduction

This document describes the features and functions of the 10GBASE-KR Ethernet targeted
reference design (LOGBASE-KR TRD). It also describes how to set up, operate, test, and modify
the design.

10GBASE-KR TRD Overview

The 10GBASE-KR TRD (Figure 1-1) targets the Kintex® UltraScale™ XCKU040-2FFVA1156C
FPGA running on the KCU1250 characterization board. It demonstrates connectivity
between the 10-Gigabit Ethernet PCS/PMA IP core (L0GBASE-KR) and the 10-Gigabit
Ethernet MAC IP core (10G MAC) and error free traffic flow on this 10-Gigabit Ethernet
channel across a backplane.
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Figure 1-1: The 10GBASE-KR TRD

10GBASE-KR is defined in IEEE Std 802.3-2012 [Ref 1]. It specifies the 10 Gb/s physical layer
specification using 10GBASE-R encoding over an electrical backplane.

The 10GBASE-KR TRD has two 10 Gb/s Ethernet channels; channel 0 and channel 1. Transmit
data is generated by the Traffic Generator and Monitor block. Data from one channel is
looped back to the other channel on a backplane through SMA cables as shown in

Figure 3-2. The looped-back data becomes the receive data on the other channel and the
frame length and frame check sequence (FCS) are verified by the 10-Gigabit Ethernet MAC
IP core.

A MicroBlaze™ processor subsystem monitors the 10-Gigabit Ethernet MAC IP core
statistics. It also controls the Traffic Generator and Monitor block and reports Ethernet
performance. It passes this information to the Ethernet Controller application GUI running
on the control computer via the USB-to-UART port on the KCU1250 board.

10GBASE-KR Ethernet TRD N Send Feedback 6
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Components, Features, and Functions

The 10GBASE-KR TRD includes:

» 10-Gigabit Ethernet PCS/PMA IP core (10GBASE-KR):

o

o

o

o

o

Uses GTH transceivers running at 10.3125 Gb/s line rate.

Provides a single data rate (SDR) 10-Gigabit Ethernet Media Independent Interface
(XGMII) which connects to the 10-Gigabit Ethernet MAC IP core. The XGMII interface
runs at 156.25 MHz and the data path is 64-bits wide.

Provides a serial interface to connect to the backplane.
Auto-negotiation (AN) and forward error connection (FEC) is enabled.

Is monitored and configured through status and configuration vectors.

« 10-Gigabit Ethernet MAC IP core (10G MAC):

o

o

o

Connects to the 10-Gigabit Ethernet PCS/PMA IP core using the XGMII interface.

Provides AXI4-Stream protocol support on the user interface running at
156.25 MHz.

Is monitored through an AXI4-Lite interface.

« Traffic Generator and Monitor:

o

o

o

Generates Ethernet traffic.

Monitors bandwidth utilization on the transmit and receive AXI4-Stream interfaces
of the 10-Gigabit Ethernet MAC IP core.

Is configured and monitored through an AXI4-Lite interface.

« AXI UART Lite:

o

Provides the controller interface for asynchronous serial data transfer. This interface
connects to the USB-to-UART port on the KCU1250 board, and is used to
communicate with the control computer.

Provides an AXI4-Lite interface to communicate with the MicroBlaze processor
subsystem.

* MicroBlaze processor subsystem and AXI Interconnect:

o

10GBASE-KR Ethernet TRD

Communicates with the 10-Gigabit Ethernet MAC IP core, Traffic Generator and
Monitor, and AXI UART Lite using the AXI4-Lite protocol.

Drivers running on the MicroBlaze processor subsystem interpret commands
received from the Ethernet Controller application GUI running on the control
computer and convert them to AXI4-Lite transactions.

o l Send Feedback I 7
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« Ethernet Controller application GUI/Driver:

- Provides a graphical user interface running on the control computer to pass user
inputs to the 10GBASE-KR TRD and to display status through the KCU1250 board
USB-to-UART port.

+ Eye scan system:
o AXI DRP bridge:

- Custom logic that allows access to DRP registers of the transceiver through any
AXI master such as the MicroBlaze processor subsystem.

o AXI block RAM controller:

- An AXIslave IP core that allows access to local block RAM by AXI master devices
such as the MicroBlaze processor subsystem and the JTAG to AXI Master IP core.

- The block RAM stores the data read from the DRP port of the transceiver.
o JTAG to AXI Master:

- An AXI Master IP core that can generate AXI transactions and drive AXI signals
internal to FPGA in the system.

- Communicates with the AXI block RAM controller via the AXI Interconnect.

- Allows the Vivado logic analyzer Tcl console running on the control computer to
interact with FPGA through the USB-to-JTAG port on the KCU1250 board.

- MicroBlaze processor subsystem:

- An AXI Master that communicates with the AXI DRP bridge and AXI block RAM
controller via the AXI Interconnect.

- Drivers running on the MicroBlaze processor subsystem implement an algorithm
to measure a statistical eye (bit error ratio (BER) versus time and voltage offset).
Data sampling points are available to read via the DRP port of the transceiver.
Point-by-point measured data is stored in a block RAM to be burst read by the
control computer via the JTAG to AXI Master.

o AXI Interconnect:

- Allows multiple AXI masters (MicroBlaze processor subsystem and JTAG to AXI
Master) to communicate with multiple AXI slaves (AXI DRP Bridge and AXI block
RAM controller).
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Resource Utilization

Chapter 1: Introduction

Table 1-1 lists the resources used by the 10GBASE-KR TRD after synthesis has run. Place and
route can alter these numbers based on placements and routing paths, so use these
numbers as a rough estimate of resource utilization. These numbers might vary based on
the version of the 10GBASE-KR TRD and the tools used to regenerate the design.

Table 1-1: 10GBASE-KR TRD Resource Utilization

Site Type Used Available Usage (%)
CLB LUTs 29,846 242,400 1231
CLB Registers 41,794 484,800 8.62
Block RAM Tile 42 600 6.91
Global Clock Buffers 2 240 0.83
BUFG_GT_SYNC 6 55 10.90
BUFG_GT 6 120 5.00
GTHE3_CHANNEL 2 20 10.00
GTHE3_COMMON 2 5 40.00

10GBASE-KR Ethernet TRD

UG1058 (v2016.3) November 28, 2016
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Chapter 2

Setup

)

10GBASE-KR Ethernet TRD

This chapter lists the requirements and describes how to do all preliminary setup of the

KCU1250 board, control computer, and software before bringing up the 10GBASE-KR TRD.

IMPORTANT: Perform the procedures described in this chapter before performing the bring up
procedures described in Chapter 3, Bringing Up the Design.

Requirements

Hardware

»+ KCU1250 board with the Kintex® UltraScale™ XCKU040-2FFVA1156C FPGA [Ref 2]
« Two USB cables, standard-A plug to micro-B plug

« Power Supply: 100 VAC-240 VAC input, 12 VDC 5.0A output

« Backplane: z-Pack TinMan Customer System kit from Tyco Electronics [Ref 3]

« Two SamTec Bulls Eye cables from Avnet [Ref 4]

« Four DC Blocks/AC capacitors from Aeroflex [Ref 5]

Computer

One computer is required, and is identified as the control computer throughout this

document. It is required for running Vivado Design Suite, configuring the FPGA, and

running the Ethernet Controller application GUI to control and monitor the reference
design. It can be a laptop or desktop computer with Microsoft Windows 7 Operating
system.

Design Tools and Software

« Vivado® Design Suite 2016.3

« USB UART drivers (CP210x VCP drivers) [Ref 6]
« Tera Term [Ref 7]

o l Send Feedback I
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« Java SE Runtime Environment 7
« Ethernet Controller application GUI (included with the 10GBASE-KR TRD)
« 10GBASE-KR Ethernet targeted reference design files

Download and installation instructions for each required software application and for the
10GBASE-KR Ethernet targeted reference design files are described in Preliminary Setup.

Preliminary Setup

Complete these tasks before bringing up the design described in Chapter 3, Bringing Up
the Design.

Install Vivado Design Suite

Install Vivado Design Suite 2016.3 on the control computer. Follow the installation
instructions provided in Vivado Design Suite User Guide Release Notes, Installation, and
Licensing (UG973) [Ref 8].

Download Targeted Reference Design Files

1. Download the 10GBASE-R TRD ZIP file rdf0310-kcul250-trd05-2016-3.zip from
KCU1250 Characterization Kit Documentation.

2. Unzip the contents of the file to a working directory.

3. The unzipped contents will be located at
<working_dir>/kcul250_10gbasekr_trd.

The 10GBASE-KR TRD directory structure is described in Appendix A, Directory Structure.

Install the USB UART Drivers

Download the CP210x USB to UART Bridge VCP drivers (for Windows 7) from Silicon Labs.
Follow the instructions in Silicon Labs CP210x USB-to-UART Installation Guide (UG1033)
[Ref 9].

UG1058 (v2016.3) November 28, 2016 www.xilinx.com [—\/—]
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Configure the Control Computer COM Port

The TRD uses the Tera Term Pro terminal emulator and the Ethernet Controller application
GUI to communicate between the control computer and the KCU1250 board. To configure
the control computer COM ports for this purpose:

1. Place switch SW1 to the OFF position. (SW1 in Figure 2-1).

2. Connect the KCU1250 board to the control computer and power supply as shown in
Figure 2-1.

O TIP: Figure 2-1 shows only the top edge of the KCU1250 board.

Control
Power Supply Computer
100VAC—-240VAC Input

12 VDC 5.0A Output

USB cable
standard-A plug

ﬁ—to micro-B plug

Board Power
Switch SW1

J28 12 VDC To U8B0

J1
USB UART USB JTAG

—

)_(Nlux:.{,-m W ﬂ &“ﬁ it -

.....

.....

UG1058_c2_01_071014

Figure 2-1: Connections for Preliminary Setup

3. Power on the KCU1250 board by placing switch SW1 to the ON position. (SW1 in
Figure 2-1).

10GBASE-KR Ethernet TRD 12
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4. Open the control computer Device Manager. In the Windows task bar, click Start, click
Control Panel, and then click Device Manager.

5. In the Device Manager window (Figure 2-2), expand Ports (COM & LPT), right-click
Silicon Labs CP210x USB to UART Bridge: Standard COM Port, and then click
Properties.

, |
YT =T

File Action View Help

ol AR L]
g IDE ATASATAPI controllers o
-5 Imaging devices
b ¥ Jungo
b £ Keyboards
I b --ﬂ Mice and other pointing devices
b -l Monitors
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I ----- L¥ Bluetooth Device (Personal Area Metwork) I
----- l_-? Bluetooth Device (RFCOMM Protocol TDI)
I ----- 1y Cisco Systems VPN Adapter for 64-bit Windows
----- ¥ Intel(R) 82579LM Gigabit Network Connection

----- L¥ Intel(R) Centrino(R) Ultimate-N 6300 AGN
----- £¥ VirtualBox Host-Only Ethernet Adapter
475 Ports (COM & LPT)

m

» Processors

b j Smart card readers

b -% Sound, video and game controllers
b A7 Storage controllers

]
UG1058_c2_02_061714

Figure 2-2: Device Manager

TIP: Make note of the COM port numbers assigned by the control computer OS in your setup to Silicon

O Labs CP210x USB to UART Bridge: Standard COM Port and Silicon Labs CP210x USB to UART
Bridge: Enhanced COM Port. The Enhanced COM port number must be provided to the Tera Term Pro
terminal emulator in step 2, page 15. The Standard COM port number must be provided to the Ethernet
Controller application in step 2, page 31.
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6. In the properties window, select the Port Settings tab (Figure 2-3).

7. Set Bits per second, Data bits, Parity, Stop bits, and Flow control to the values shown
in Figure 2-3, and click OK.

P

~
Silicon Labs Dual CP210x USE to UART Bridge: Standard COM Por... ﬁ

General | Port Settings |Driver | Details | Power Managementl

Bis per second: (115200 -
Data bits: [8 - |
Party: | None v
Stop bits: (1 -
Flow control: | Nene v

| Advanced.. | | Restore Defautts |

[ ok || Cancel

UG1058_c2_03_061714

Figure 2-3: Port Settings

8. In the Device Manager window (Figure 2-2), expand Ports (COM & LPT), right-click
Silicon Labs CP210x USB to UART Bridge: Enhanced COM Port and then click
Properties.

9. In the properties window, select the Port Settings tab and set Bits per second, Data
bits, Parity, Stop bits, and Flow control to the values shown in (Figure 2-3), and then
click OK.
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Install Tera Term Pro Software

1. Follow the download and installation instructions provided in Tera Term Terminal
Emulator Installation Guide (UG1036) [Ref 10].

2. To communicate with the KCU1250 board, configure the new Tera Term connection and
serial port settings as shown in Figure 2-4. These settings must match the control
computer COM port settings shown in Figure 2-3. Select the serial COM port associated
with Silicon Labs Dual CP210x USB to UART Bridge: Enhanced COM Port.

Tera Term: New connection M Tera Term: Serial port seh.l|-

X
) TCP{IP myhost.example.com Port: COM17 -
History Baud rate: 115200 -
Telnet 22
_ Data: 8 bit - Cancel
© S3H SSH2 )
Other Parity:
UNSPEC
. . o Flow control:
@ Serial Port: ICOM] ¥: Silicon Labs Dual CP210x UL ~
Transmit delay
[ Ok l l Cancel ] ’ Help ]

0 msecichar 1] msecfline

UG1058_c2_04_061714

Figure 2-4: Tera Term Pro Settings

Install Java

Download Java SE Runtime Environment 7 from Oracle [Ref 11] and install the program on
the control computer. Follow the installation instructions provided with the software.
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Install the Ethernet Controller Application

1. Browse to <working_dir>/kcul250_1l0gbasekr_trd/software/GUI
(Figure 2-5).

[ = e |
@ ' | o & work v keul250 10gbasekr trd » software » GUI - Search GUI gl

File Edit View Tools Help

Include in library « Share with « Burn Mew folder

Organize «
Date modified

-~

- Favorites SETE

PR Desktop

4 Downloads

ﬂ, EthernetController-32-installer 5/1/2014 6:47 PM Application
= & EthemetController-64-installer 5/1/2014 6:46 PM  Application

L
= Recent Places

L My Site

i Libraries
3 Documents
,J'. Music
(=] Pictures
B wideons
l 2 items
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Figure 2-5: Directory Location, Ethernet Controller Installer

2. Right-click either the EthernetController-32-installer (for a 32-bit operating system)
or EthernetController-64-installer (for a 64-bit operating system) and select Run as

administrator (Figure 2-5).

3. Click Yes in the dialog box that opens.
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Chapter 2:

Setup

4. In the License Agreement display (Figure 2-6), click I Agree to continue installation.

$. Xilinx - EthernetContraller Setup: License Agreement l = |ﬂh,|

¥ Please review the license agreement before installing Xilin: -
4 EthernetContraller. If you accept all terms of the agreement, dick T Agree.

KILIMX, INC.
EMD USER. LICEMSE AGREEMENT

CAREFULLY READ THIS END USER LICEMSE AGR.EEMENT ("AGREEMENT™). BY
CLICKING THE "ACCEPT™ OR "AGREE" BUTTOM, OR OTHERWISE ACCESSING,
DOWMLOADIMG, INSTALLING OR USING THE SOFTWARE, YOU AGREE OM
BEHALF OF LICENSEE TO BE BOUND BY THIS AGAEEMENT.

IF LICEMSEE DOES MOT AGREE TO ALL OF THE TERMS AMD COMDITIONS OF
THIS AGRFFMFMT . N0 MOT O TOK THF "ACCFPT™ OR "AGRFFTRLITTON OR

Cancel | I Agree
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Figure 2-6: License Agreement

5. Browse to the location where the Ethernet Controller application will be installed and
click Install (Figure 2-7).

10GBASE-KR Ethernet TRD

§. Xilinx - EthernetController Setup: Installation Folder l = ﬂh,l

¥ Setup will install Xilinx - EthernetController in the following folder. To install
4 inadifferent folder, dick Browse and select another folder. Click Install to
start the installation.

Destination Folder

»Wilin\EthernetContraller| Browse. ..

Space required: 3.0MB
Space available: 31.5GE

Cancel | < Back | Install |

UG1058_c2_07_061714

Figure 2-7: Ethernet Controller Installation Location
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Setup

6. Click Close after installation is complete (Figure 2-8).

§. Xilinx - EthernetController Setup: Completed l — | |" Ea ‘]

¥ Completed

4 ENNENNEEEEEEEEEEEENEEENEEEEEEEEN]

Show detzils

==

UG1058_c2_08_061714

Figure 2-8: Installation Complete

TIP: To uninstall the Ethernet Controller application after design bring up, open the Control Panel. In
O the Control Panel click All Control Panel Items>Programs and Features and uninstall program
“Xilinx Ethernet Controller - Powered by Xilinx.”

Ready to Bring Up the Design

After all procedures in this chapter are complete, go to Chapter 3, Bringing Up the Design.

10GBASE-KR Ethernet TRD
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Chapter 3

Bringing Up the Design

~>>
-

This chapter describes how to bring up the 10GBASE-KR TRD. Instructions are provided for
setting up the KCU1250 board and backplane, programming the clock, programming the
FPGA, configuring virtual input/output (VIO), and running the Ethernet Controller
application.

IMPORTANT: Perform the preliminary setup procedures described in Chapter 2, Setup before
performing the bring up procedures described in this chapter.

Set Up the KCU1250 Board

Connect BullsEye Cables

1. Connect the SAMTEC Bulls Eye cables to J41 (GTH Transceiver Quad_226) and J42 (GTH
Transceiver Quad_227) as described in this video:

VIDEO: New GTX/GTH/GTZ Interconnect on Xilinx Characterization Boards

2. The Bulls Eye SMA cables are numbered. Cable 15 is TX0_P, cable 16 is TXO_N, cable 17
is RXO_P and cable 18 is RXO_N. Connect the AC capacitors (Aeroflex SMA DC Blocks—
[Ref 5]) to TXN and TXP SMA connector on both Bulls Eye cables. Refer to pages 51 and
52 of the KCU1250 Characterization Board Schematics (XTP398) [Ref 12].
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3. Connect the SMA cables on the Bulls Eye connector to the Tyco backplane as shown in

Figure 3-1.
TYCO BACKPLANE
COL6 COL6
COUNTER COUNTER
BORED BORED
O O[O0 OO0 O |0 O O O] [0 OO0 OO0 O
O O[O0 OO0 O |0 O O OO0 O] |0 O 10 O
O O[]0 OO0 O] |0 O O Ol |0 Ool|0 Ol |0 O
) ) (D) T ) ( O O O O O O
Trace Length 16"
0 O I 0 0 0 O Q1O Ol 1O Ol |O O
1! BN [
gl_‘ﬂl.‘ zz‘ o 2z
2% & =
¥ ¥
Ja1 J42
GT X0Y8 Transmit Receive GT x0v12
Bank 226 Bank 227

UG1058_c3_01_031015

Figure 3-1: SMA Connections to the Backplane

4. SMA cable 19 is REFCLKO_C_P and cable 20 is REFCLKO_C_N. Connect cable 19 and cable
20 from J41 to the clock out pins of Oscillator Si5368 on the Superclock module.
Connect cable 19 and cable 20 from J42 to the clock out pins of Oscillator Si570 on the
Superclock module.

5. Connect the power supply to the KCU1250 board.

6. Connect one end of the Micro-USB cable to USB-UART port (J1) and the other to the
Control PC.

7. Connect one end of the Micro-USB cable to USB-JTAG port (U80) and the other to the
Control PC.
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All above connections are shown in Figure 3-2.

Connect SMA cables
15,16,17 and 18 from
J42 to the backpane

Connect SMA cables
15,16,17 and 18 from
J41 to the backpane

Connect AC caps Connect AC caps
toTXN/TXP SMAs OTXN/TXP SMAs
T — __ - c

Board
Power

Super-Clock Il
Switch SW1

Module

To U80 J1

USB JTAG USB UART
Connect SMA Connect SMA
cables 19 and 20 cables 19 and 20
Control from J42 to Si570 from J41 to Si5368
Computer
Power Supply
A 100VAC-240VAC Input

USB cable 12 VDC 5.0A Output

standard-A plug
to micro-B plug

UG1058_c3_02_062014

Figure 3-2: KCU1250 Board Connections Including SMA Connections to the Backplane

8. Power on the KCU1250 board by placing switch SW1 to the ON position.

10GBASE-KR Ethernet TRD N Send Feedback 21
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Program the Clocks Sources

The KCU1250 board uses the SuperClock-2 module to provides programmable, low-noise
and low-jitter clock sources for the KCU1250 board. See HW-CLK-101-SCLK2 SuperClock-2
Module User Guide (UG770) [Ref 13] for more information.

To program the clock sources:

1. On the control computer, open the Tera Term Pro terminal program. Click Start > All
Programs > Tera Term > Tera Term.

2. Inthe New connection window, configure the settings as shown in Figure 3-3. Select the
serial COM port associated with Silicon Labs Dual CP210x USB to UART Bridge: Enhanced COM Port.
Click OK.

¥ Tera Term - [disconnected] VT

File Edit Setup Contrel Window Help

Tera Term: New connectio l]

TCPHP myhost.example.com
History
Telnet
$SH S$SH2
Other

22

UNSPEC

@ Serial Port: [COM3: Intel(R) Active Management Tec ~

COM3: Intel(R) Active Management Technology - SOL (COM3)
l e COMI16: Silicon Labs Dual CP210x USB to UART Bridge: Standard COM P

UG1058_c3_03_022315

Figure 3-3: Connect to Enhanced COM Port on Tera Term

3. On the control computer keyboard, press the Enter key. The Tera Term window will
display the SuperClock-2 configuration menu.

4. Set Programmable Clocks:
a. Select option 1 (Set Programmable Clocks): Type 1, and press Enter.
5. Set the Si570 frequency to 156.25 MHz:
a. Select option 1 (Set KCU1250 Si570 frequency): Type 1, and press Enter.
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b. Enter the Si570 frequency in MHz: Type 156.25 and press Enter.

6. Set the Si5368 frequency to 156.25 MHz:
a. Select option 2 (Set KCU1250 Si5368 frequency): Type 2, and press Enter.
b. Enter the Si5368 frequency in MHz: Type 156.25 and press Enter.

¢. Choose Si5368 operating mode (Select Free-Run using XA-XB crystal): Type 2, and
press Enter.

7. Close the Tera Term Pro terminal program window.

Program the FPGA

1. Launch the Vivado Integrated Design Environment (IDE) on the control computer:

a. In Windows, select Start > All Programs > Xilinx Design Tools >
Vivado 2016.3 > Vivado 2016.3.

b. On the getting started page, click Open Hardware Manager (Figure 3-4).

File Flow Tools Window Help

VIVADO! s s

Quick Start
para & |
T = -'
% /
Create New Project Open Project Open Example Project
Tasks
Ve (F &
=%
[l E‘
Manage IP Open Hardware Manager Xilinx Tcl Store

Information Center

Documentation and Tutorials Quick Take Videos Releaze Notes Guide

UG1058_c3_04_032415

Figure 3-4: Open Hardware Manager
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2. Open the connection wizard to initiate a connection to the KCU1250 board:

a. Click Open a new hardware target (Figure 3-5).
File Edit Flow Tools Window Layout View Help
2w 0B X | %3 | LogcAnalyzer " HeR®
| Hardware Manager - unconnected
| @ Mo hardware target is opefl. Cpen target
Hardware E}, Auto Connect g Probes S I I Eal 4
Ll ] =l g ([
e = —Iih E pl»HE Recent Targets LG E:
Mame : -
1| 1]
--------- UG1058_c3_04_03241 f:
Figure 3-5: Open a New Hardware Target
b. Configure the wizard to establish connection with the KCU1250 board by selecting
the default value on each wizard page. Click Next > Next > Next > Finish.
¢. In the hardware view, right-click xcku040 and click Program Device (Figure 3-6).
File Edit Flow Tools Window Layout View Help |Qv Search commands |
A2 e E X K@ [Echteer XKD
| Hardware Manager - locahost/xinx _tcf/Digient/210251833653 x|
|® There are no debug cores. Program device Refresh device
Hardware —Oe =x Debug Probes — O
aZ=E M E o T =E
Name Status
El-ﬂ localhost | Connected
il (1) Open
1 Hardware Device Properties. .. Ctrl+E
Program Device...
Refresh Device
Hardware Device Properties
rl—‘ % Add Configuration Memary Device...
;x$0§0 R Export to Spreadsheet...
Mame: xckud40_0 é
Part: xckud40
1D code: 03822093 ;
Properties ‘
UG1058_c3_06_032415
Figure 3-6: Select Device to Program
d. In the Bitstream file field, browse to the location of the BIT file:

<working_dir>/kcul250_10gbasekr_trd/ready_to_test/kcul250_10gb

asekr_download.bit

10GBASE-KR Ethernet TRD
UG1058 (v2016.3) November 28, 2016 www.xilinx.com

l Send Feedback l 24


https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=24

8 XI LINX Chapter 3: Bringing Up the Design

ALL PROGRAMMABLE.-
e. In the Debug Probes file field, browse to the location of the probes file:
<working_dir>/kcul250_10gbasekr_trd/ready_to_test/debug nets.ltx

and click Program (Figure 3-7).

-
g‘”_ Program Device

,"/ \"| Select a bitstream programming file and download it to your hardware device. You can optionally select a
" debug probes file that corresponds to the debug cores contained in the bitstream programming file.

Bitstream file: Crfworkkcu1250_10gbasekr _trdfready_to_testfkou1250_10gbasekr_download.bit E]

Debug Probes file: | C:fworkfkcu1250_10gbasekr_trdfready_to_test/debug_nets.|tx

’ Frogram ” Cancel ]

UG1058_c3_07_032415
Figure 3-7: Program Device Window

After completing these steps, continue on to Configure VIO.

Configure VIO

There are six virtual I/O (VIO) cores in the reference design. After programming, each VIO
core can be controlled in the Vivado IDE. To add probes to each VIO window:

1. Open the Debug Probes window: on the top panel of the Vivado IDE click Window >
Debug Probes.

2. In the Debug Probes window, right click on hw_vio_1 and select Add probes to VIO
Window (Figure 3-8).

3. Repeat the same procedure for hw_vio_2, hw_vio_3, hw_vio_4, hw_vio_5 and
hw_vio 6.
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Fle Edit Flow Tools Window Layout View Help Search commands
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hwi_vio_3 ) OK - Outputs Reset [H-t5 cho_a
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hwi_vio_5 (VIO) OK - Outputs Reset -la chd_a Add Probes to VIO Window
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VIO Core Properties _ 0O = e chU:cIear_an_page_rz % Press the = button to add probes
= --a chi_clear_an_remote_
Qi QJ % ‘a cho_clear_pcs_link_fal
3E hw_vio_1 -la ch0_clear_pma_pmd_
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--ta chi_fec_uncorr_blocks
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Figure 3-8: Adding a Probe to a VIO Window

Table 3-1 shows what each VIO window configures and monitors.

Table 3-1: VIO Tab Mapping

VIO Tab Mapping Comments
. L Configures the DRP port for channel 1 through the training port of the
1) *
hw_vio_6 training_*_chl 10-Gigabit Ethernet PCS/PMA IP core.
. L Configures the DRP port for channel 0 through the training port of the
@ *
hw_vio_5 training_*_ch0 10-Gigabit Ethernet PCS/PMA IP core.
hw_vio_4() stat_ch1 * Monitors the status vector signals of the 10-Gigabit Ethernet PCS/PMA
IP core for channel 1.
hw_vio_3(®) stat_ch0_* Monitors the status vector signals of the 10-Gigabit Ethernet PCS/PMA
IP core for channel 0.
hw_vio_2(D) chl * Configures the configuration vector signals of the 10-Gigabit Ethernet
PCS/PMAIP core for channel 1.
hw_vio_1() cho_* Configures the configuration vector signals of the 10-Gigabit Ethernet
PCS/PMAIP core for channel 0.
Notes:

1. The value of n in hw_vio_n might change based on how the Vivado Synthesis tool processes the netlist. You might have to
redo the above mapping accordingly.
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4. Verify if stat_chO_pcs_rx_link_status and stat_chl_pcs_rx_link_status is 1. This indicates
that the 10GBASE-R link is up (Figure 3-9).
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Figure 3-9: Verify Link Status
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5. Enable FEC, Training and Auto Negotiation on both channels by configuring signals in
the ch0_* and ch1_* VIO windows. Here is the sequence to follow:

a. Advertise Channel 1 is KR capable:
Set value 0080 on chl _an_adv_data_31 16

b. Advertise Channel 1 supports FEC and is requesting FEC support from the partner:
Set value C000 on chl_an_adv_data_47_32

c. Pulse chl an_ad to load the AN data bits for Channel 1:

Set value 1 on chl_an_ad
Set value 0 on chl_an_ad

d. Advertise Channel 0 is KR capable:
Set value 0080 on chO_an_adv_data_31_16

e. Advertise Channel 0 supports FEC and is requesting FEC support from the partner:
Set value C000 on chO_an_adv_data_47_32

10GBASE-KR Ethernet TRD
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f. Pulse chO_an_ad to load the AN data bits for Channel 0:
Set value 1 on chO_an_ad
Set value 0 on chO_an_ad

g. Enable FEC on channel 1:
Set value 1 on chl_enable_fec

h. Enable FEC on channel O:
Set value 1 on chO_enable_fec

i. SetTraining done to 1 on channel 1. This indicates to Training Algorithm that the LP
transmitter has been successfully trained:
Set value 1 on chl_training_done

j. Enable Training on channel 1:
Set value 1 on chl_enable_training

f IMPORTANT: Due to strict timing requirements on chl_training_done, and the slow nature of executing
Tcl commands in Vivado, the chl_training_done command is executed before chl_enable_training
command. This may not be true if executing these commands from a microprocessor.

k. SetTraining done to 1 on channel 0. This indicates to the Training Algorithm that the
LP transmitter has been successfully trained:
Set value 1 on chO_training_done

|.  Enable Training on channel 0:
Set value 1 on chO_enable_training

f IMPORTANT: Due to strict timing requirements on ch0_training_done, and the slow nature of executing
Tcl commands in Vivado, the chO_training_done command is executed before chO_enable_training
command. This may not be true if executing these commands from a microprocessor.

m. Enable Auto Negotiation on channel 1:
Set value 1 on chl_en_auto_negotiation

n. Enable Auto Negotiation on channel O:
Set value 1 on ch0_en_auto_negotiation

0. Pulse Reset Auto Negotiation on channel 1:
Set value 1 on chl_reset_autonegotiation, and then
Set value 0 on chl_reset_autonegotiation

ﬁ IMPORTANT: Only reset one side of the channel. In this example, only Channel 1 is reset.

To toggle the VIO signals in the sequence as described in step 5 a Tcl script is provided
in:

<working_dir>/kcul250_10gbasekr_trd/ready_to_test/en_fec_tr_an.tcl
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Source the script in the Tcl console of the Vivado IDE as shown in Figure 3-10.

Chapter 3:

Bringing Up the Design

File
A2 R M X | B | E S pefault Layout

Edit Flow Tools Window Layout View Help

T HeN| & ®

| Hardware Manager - localhost/xilinx_tcf/Digilent/210251845478

Hardware —Ow =

Q

Status
Connected

Open

OK - Outputs Reset

Mame

OK - Outputs Reset
OK - Outputs Reset

OK - Outputs Reset

Hardware Device Properties

ald Y

& xcku040_0

I
X

»

¥ckundn 0 -
f [ il | »

=L

Debug Probes

Gl pig
pig A

OK - Outputs Reset ==t

OK - Outputs Reset RN

FECC G EE T RETREEEEETES

cho_enable_fec
ch0_enable_training
ch0_ext_next_page_support
ch0_fec_corr_blocks
cho_fec_signals_err_to_pcs
chi_fec_uncorr_blocks
ch0_ld_training_intialize
ch0_ld_training_preset
cho_ld_training_vendor[5:0]
ch0_lp_coeff_intialize
ch0_lp_coeff_preset
ch0_lp_coeff_update[5:0]
ch0_pcs_loopback_enable
ch0_pcs_reset
ch0_pma_loopback_enable
ch0_pma_reset
cho_pmd_tx_disable
ch0_reset_autonegotiation
ch0_restart_autonegotiation
ch0_restart_training
cho_set_an_link_up_down
ch0_set_pcs_link_status
ch0_set_pma_link_status
ch0_training_done
hw_wio_2

Properties

4]

I

|

=

3=

Tel Console

'prc:gram_hw_:levices [lindex [get_hw_dewvices] 0]
NFO: [Labtools 27-3164] End of startup status: HIGH
- program hw_devices: Time (3):
:re:'resh_hw_device [lindex [get_hw devices] 0]
NFQ: [Labtools 27-2302] Device xckul40 (JTAG device
" INFO: [Labtools 27-2302] Device xcku040 (JTAG device

i@ = 4k B

X

cpu = 00:00:10 ; elapsed = 00:00:10 .

Memory (MB):

index =
index =

et_property FROGRAM.FILE {[C:/work/kcul250_lOgbasekr_trd/ready_to_test/kcul250_lOgbasekr_dm

peak = E70.

0) is programmed with a design
0) is programmed with a design
efresh hw _vic -update_ocutput values [get_hw vies {hw vic_l hw vic 2 hw_wic_ 3 hw_vic 4 hw_w:

I source c:/work/kcul250_lOgbasekr trd/ready_to_teat/enable_fec_tr_an. th

I

\I Tl Consolel = Messages L% Serial /O Links ]

Figure 3-10:
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Verify if Auto Negotiation is complete (an_complete) and the 10GBASE-KR is negotiated
successfully in the stat_chO0* and stat_ch1* VIO windows (Figure 3-11). It should take only a
second or two for 10GBASE-KR IP core to negotiate successfully after executing the script.

& hw_wios X o % % hw_vios X [ E
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Figure 3-11: AN Complete and KR Negotiated
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Running the Design

Launch the Ethernet Controller Application

1. Launch the Ethernet Controller application GUI on the control computer. In Windows,
click Start > All Programs > Xilinx > EthernetController (Figure 3-12).

. Tera Term Default Programs
. TransVault Insight

. WebEx Help and Support
. WinPcap

. Windip

2 Kilinx

£ EthemetContraller

Back

UG1058_c3_12_061014
Figure 3-12: Launch Ethernet Controller Application

2. Select the COM port associated with the Silicon Labs CP210x USB-to-UART
Bridge: Standard COM Port and click Connect (Figure 3-13) to open the Ethernet
Controller application for the 10GBASE-KR TRD.

TIP: The COM port associated with the Silicon Labs CP210x USB-to-UART Bridge: Standard COM Port
O can be identified using the Windows device manager. See step 4, page 13.

o -
| £| Ethernet Controller

Ethernet Controller

COM Port: COM1 v

COmM17

LPT1

UG1058_c3_13_061014

Figure 3-13: Select COM Port Associated with the USB-to-UART Bridge
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Running the Traffic Generators

1. Ethernet channel 0 and channel 1 are up and ready when the ETHO PHY and ETH1 PHY
indicators are green (Figure 3-14).In the control panel for both channel 0 and channel 1,
select Internal Generator and enter 1500 in the payload field. Click Start.

,

m KUCon-TRDO5 10GBASE-KR Ethernet Targeted Reference Design
DGRAMMAR ® ETHOPHY @ ETH1PHY

E—

Channel 0 Channel 1

Control Panel Control Panel

O Internal Generator O Internal

atol
Payload: 1500 - Payload: -

Tx Statistics Rx Statistics Tx Statistics Ry Statistics

Throughput (Gbps): 0.00 Throughput (Gbps): 0.00 Throughput (Gbps): 0.00 Throughput (Gbps): 0.00

Packet Count: 0 FEEEEE 0 Packet Count: 0 FERRIERIE g

l Tx Throughput ™ Rx Throughput l Tx Throughput ™ Rx Throughput

UG1058_c3_14_061014

Figure 3-14: Set Payload Size on Channel 0 and Channel 1
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Figure 3-15 shows the performance achieved at this payload size is 9.74 Gb/s per
channel per direction. The allowed payload values that can be entered are 46 bytes to
1,500 bytes.

KUCon-TRDO5 10GBASE-KR Ethernet Targeted Reference Design
® ETHOPHY @® ETH1PHY

——
Ferformance Piots | CRAnnel 0 Staistcs.|| Ghannel 1 satsics |

Channel 0 Channel 1

Control Panel Control Panel

Payload:

Tx Statistics Rx Statistics Tx Statistics Rx Statistics
Throughput (Gbps): 9.74 Throughput (Gbps): Q.74 Throughput (Gbps): 9.7. Throughput (Gbps):

EELe Packet Count 811316 Packet Count 811688 FEAmIEE

W Tx Thr Dughput W Ry Throughput W Tx Thr Dughput B Rx Throughput

UG1058_c3_15_061014

Figure 3-15: Throughput Performance Plots

TIP: The relationship between payload size and throughput can be demonstrated by changing the
O payload size. Reducing the payload size causes a dip in performance. Refer to Appendix B, Performance
Estimates for performance estimation on 10G Ethernet protocol.

2. Stop traffic generation by clicking Stop for both channels.

10GBASE-KR Ethernet TRD N Send Feedback 33
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3. Select the Channel 0 Statistics tab and verify if any packets were in error or were
dropped (Figure 3-16).

,

m KUCon-TRDOS 10GEASE-KR Ethernet Targeted Reference Design
Eas @® ETHOPHY @ ETH1PHY

_—

Tx Statistics Rx Statistics

Throughput (Gbps): 0.00 Packet Count: 0 Throughput (Gbps): 0.00 Packet Count:

[ Type out g
Fragment frames received

Underrun errors

UG1058_c3_16_061014

Figure 3-16: Channel 0 MAC Statistics

4. Next, select the Channel 1 Statistics tab and verify if any packets were in error or were
dropped (Figure 3-17):

o The TX MAC statistics for Channel 0 should match the RX MAC statistics of
Channel 1.

o The TX MAC statistics for Channel 1 should match the RX MAC statistics of
Channel 0.
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| £/ 10GBASE-R Ethernet TRD

m KUCon-TRDO5 10GBASE-KR Ethernet Targeted Reference Design
Baus @ ETHOPHY @ ETH1PHY

Permanes | Chama OSaReie | Crane St
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Underrun errors
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Figure 3-17: Channel 1 MAC Statistics

5. Select the Performance Plots tab. Click Start for both channels to enable traffic
generation again. Run the instructions in the Generate Eye Scans section with traffic
running.

Generate Eye Scans

The JTAG to AXI Master IP core (hw_axi_1) allows the Vivado logic analyzer Tcl console
running on the control computer to interact with FPGA through the USB-to-JTAG port (U80)
on the KCU1250 board. The control computer periodically reads data samples via hw_axi_1
and creates an eye scan.

For more details refer to In-System Eye Scan of a PCl Express Link with Vivado IP Integrator
and AX14 Application Note (XAPP1198) [Ref 14].

To generate an eye scan:

1. With traffic running in the Ethernet Controller application, source the
run_eyescan. tcl script in the Tcl console of the Vivado IDE (Figure 3-18). The
command to source the script is:

source
<working_dir>/kcul250_10gbasekr_trd/ready to_test/eyescan/run_eyescan.tcl.
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f IMPORTANT: Do not disconnect the USB-to-JTAG connection. This connection is required for the control

computer to interact with the JTAG to AXI Master IP core.
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Figure 3-18: Tcl Script run_eyescan.tcl
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2. The run_eyescan command becomes available after the run_eyescan. tcl file is
sourced. To initiate a scan, type run_eyescan in the Tcl console (Figure 3-19). This
command initiates:

- Vertical and Horizontal sweeps
- Data sample collection

- Data sample processing to create an eye scan
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Figure 3-19: The run_eyescan Command
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3. The scan plots for Channel 0 and Channel 1 are shown in Figure 3-20.

Chapter 3:

Bringing Up the Design

NOTE: The Scan Plot for Channel 0 was dragged to a new Vertical group.

Y

File Edit Flow Tools window Layout View Help
A2 ;o2 X || @ |23 efault Layout
localhost/xilinx_tcf/Digilent/210251845478

Hardware R T Debug Probes — O X

AZ=E R E AZ=E
Name s ch0_an_xnp_msg_code ~
~‘a ch_an_xnp_msg_pag¢
(= B localhost (1)
[+ Ee xdilim_tcf/Digilent/210...
=1 xcku040_0 (8)

Ta ch0_an_xnp_next_pagy
a chO_an_xnp_transmit
“la ch0_clear_10gbaser_si
a ch0_clear_10gbaser_te
~‘a ch0_clear_an_page_re
‘a ch0_clear_an_remote_
a chl_clear_pcs_link_fa.
“la ch0_clear_pma_pmd_|
a ch0_en_auto_negotiati
~a ch0_enable_fec
‘a ch0_enable_training
a ch_ext_next_page_su
~la ch0_fec_corr_blocks
a ch0_fec_signals_err_tc
~‘a ch0_fec_uncorr_blocks
‘a ch0_ld_training_intializ
a ch0_ld_training_preset
44 cho_ld_training_vendor
= a ch0_lp_coeff_intialize
~‘a ch0_Ip_coeff_preset
AXI Core Propert... — O 17 X -5 ch0_lp_coeff_update[5

& hw_vm:ﬁ (VIO)

Ll T

~1a ch0_pcs_loopback_ena
_¢ - 3]k “a ch0_pes_reset
E hw_axi_1 “a ch0_pma_loopback_en
“la ch0_pma_reset
Mame:  hw_axi_1 a ch0_pmd_x_disable

~‘a ch0_reset_autonegotia
‘a ch(_restart_autonegot
‘a chO_restart_training _

Protocol: AXH_Full

General | Properties P — ;'@

Serial /O Scans

X Mame Link  Link Settings ~ Scan Type  Status

X B Scans (2)

= [E Cho_viv.csv 2d_full_eye Done
[& chi_viv.csv 2d ful_eye Done

| HeR|#®

Search commands

X
& hw_vios x | [E Scan Plots - ChO_viv.csv x oY % (=] Scan Plots - Chl_viv.csv X [m E
- Unit Interval - Unit Interval =R
- -0.469-0.312-0.156 0 0.156 0.312 -» -0.469 -0.312 -0.156 0 0156 0.312
Q @ 261
o S
B &
El E 1E-2
|~ | ~
- g J g SE-4
@ g @ ||
iy < o
& -3
Z ]
£ £ 165
H H
5E-7
1E-8
Summary Metrics T Summary Metrics M
Name: SCAN_O Open area: NfA Name: SCAN_1 Open area: N/A
Description:  Ch0_viv.csv = Description:  Ch1_viv.csv =]
Started Mar. 17 2015 01:45:50 FM Started Mar. 17 2015 01:45:50 PM
Ended: Mar. 17 2015 01:48:25 PM - Ended: Mar. 17 2015 01:48:26 PM
4 | I 3 4 1. r
—Oe x
Progress Open Area  HorzIncr  Horz Range VertIncr  VertRange  Dwell Dwell BER  Dwell Time  Start Time
100% N/A 2 v -0.500 UIto 0.500 U1 ~ 2 T 100% v BER ~ le6 & 0 Mar. 17 2015 01:45:50 PM
100% N/A 2 ~ -0.500 UTto 0.500 UT  ~ 2 ~ 100% ~ BER ~ 1e6 A 0 Mar. 17 2015 01:45:50 PN

<

15 Tl Console | © Messages | % Serial /O Links
g

[E] Serial 1/0 Scans

Figure 3-20:

1.

Eye Scan for Channel 0 and Channel 1

A=

UG1058_c3_20_032415

Forward Error Correction

To showcase forward error correction, a 10-Gigabit Ethernet PCS/PMA IP file has been
modified to inject errors in the GTH transceiver parallel data via VIO. The unmodified file is

located at:

<working_directory>/kcul250_10gbase_kr/hardware/vivado/runs/

impl_run/lO0gbasekr_trd.srcs/sources_1/bd/mac_phy/ip/
mac_phy_ten_gig _eth_pcs_pma_ch0_0/
synth/mac_phy_ten_gig_eth_pcs_pma_ch0_0_block.v

A demo BIT file is provided with the 10GBASE-KR TRD to inject errors and verify if the
Forward Error Correction (FEC) block is working as expected.

To program the FPGA with this demo:

1. Repeat Set Up the KCU1250 Board, page 19.

10GBASE-KR Ethernet TRD

UG1058 (v2016.3) November 28, 2016

www.Xilinx.com

| Send Feedback I

38


https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=38

i: XI LINX Chapter 3: Bringing Up the Design

ALL PROGRAMMABLE

2. Repeat Program the Clocks Sources, page 22.
3. Repeat step 1, page 23 and step 2, page 24 listed under Program the FPGA, page 23.
4. Program the FPGA:

a. In the Bitstream file field, browse to the location of the BIT file:

<working_dir>/kcul250_10gbasekr_trd/ready_ to_test/fec_and_err_
injection/kcul250_10gbasekr_download.bit

b. In the Debug Probes file field, browse to the location of the LTX file:

<working_dir>/kcul250_10gbasekr_trd/ready_ to_test/
fec_and_err_injection/debug_nets.ltx

c. Click Program (Figure 3-21).

g"':.'_:. Program Device I&

i | Select a bitstream programming file and download it to your hardware device. You can optionally select a
" debug probes file that corresponds to the debug cores contained in the bitstream programming file.

Bitstream file: J_10gbasekr_trdfready_to_testffec_and_err_injection/kc1250_10gbasekr_download.bit I:l
Debug Probes file: |C:fworkfkcul1250_10gbasekr_trdfready_to_test/debug_nets.ltx I:l
l Program ] | Cancel |

UG1058_c3_21_032415
Figure 3-21: Program Device Window

There are seven VIO cores in the reference design. After programming, they can be
controlled in the Vivado IDE. To add probes to each VIO window:

1. Open the Debug Probes window: on the top panel of the Vivado IDE click Window >
Debug Probes.

2. In the Debug Probes window, right click on hw_vio_1 and select Add probes to VIO
Window.

3. Repeat the same procedure for hw_vio_2, hw_vio_3, hw_vio_4, hw_vio_5, hw_vio_6, and
hw_vio_7.
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Table 3-2 shows what each VIO dashboard configures and monitors.

Table 3-2: VIO Dashboard Mapping for the FEC and Error Injection BIT File

VIO Dashboard Mapping Comments
. - Configures the DRP port for channel 1 through the training
1) *
hw_vio_7 training_"_chl | o1t of 10G Ethernet PCS-PMA IP.
. - Configures the DRP port for channel 0 through the training
1) *
hw_vio_6 training_"_ch0 | o1t of 10G Ethernet PCS-PMA IP.
hw_vio_5() stat_chl_* Monitors the status vector signals of 10G Ethernet PCS-PMA
IP for channel 1.
hw._vio_4() stat_ch0_* Monitors the status vector signals of 10G Ethernet PCS-PMA
IP for channel 0.
. Configures the configuration vector signals of 10G Ethernet
¢5) *
hw_vio_3 chl PCS-PMAIP for channel 1.
. Configures the configuration vector signals of 10G Ethernet
¢5) *
hw_vio_2 ch0_ PCS-PMA IP for channel 0.
) . . L + | Allows insertion of bit errors in transmit and receive data
hw_vio_1 insert_*_bit_error_
streams of Channel 0.
Notes:

1. The value of n in hw_vio_n may change based on how Vivado Synthesis tool processes the netlist. You might have
to redo the above mapping accordingly.

4. Verify if stat_ch0_pcs_rx_link_status and stat_chl_pcs_rx_link_status is 1. This indicates
that the 10GBASE-R link is up.

5. Enter the following Tcl script in the Vivado IDE to enable FEC, Training and Auto
Negotiation on both channels:

source <working dir>/kcul250_10gbasekr_trd/ready_to_test/enable_fec_tr_an.tcl

6. Verify if Auto Negotiation is complete (stat_ch*_an_complete) and 10GBASE-KR is
negotiated successfully (stat_ch*_bp_KR_negotiated) in stat_chO* and stat_ch1* VIO
windows.

7. Repeat the steps in Running the Design, page 31.

8. In the chl_* and ch0_* VIO windows, follow this sequence to insert errors in the data
stream:

a. Inthe chl_* and chO_* windows:

- Toggle (0 1 > 0) chl_fec_corr_blocks

\

- Toggle (0 1 > 0) chl_fec_uncorr_blocks

\%

\

- Toggle (0 1 > 0) chO_fec_corr_blocks

- Toggle (0 1 > 0) chO_fec_uncorr_blocks

\%
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This clears the stat_ch* _fec_corr_blocks and stat_ch* _fec_uncorr_blocks in the
stat chl _* and stat_chO_* VIO windows.

b. In the insert_* bit_error_* VIO window:
- Toggle (0 > 1 > 0)insert_single_bit_error_rx

- Verify the stat_chO_fec_corr_blocks count goes up. Each toggle increases the
count value by 1.

c. Inthe insert_* bit_error_* VIO window:
- Toggle (0 > 1 > 0)insert_single_bit_error_tx

- Verify the stat_chl_fec_corr_blocks count goes up. Each toggle increases the
count value by 1.

d. Inthe Ethernet Controller application, click Stop and verify channel 0 MAC statistics
and channel 1 MAC statistics for errors or packet drops. There should be none.

e. In the Ethernet Controller application, click Start to enable traffic generation on
channel 0 and channel 1.

f. In the insert_* _bit_error_* VIO window,

- Setinsert_multi_bit_rx_vector to h' FFF. This signal allows you to set the number
of bits which are in error in succession. A value of h' FFF indicates a burst of 12
bit errors.

- Toggle (0 > 1 > 0)insert_multi_bit_error_rx.

- Verify the stat_chO_fec_uncorr_blocks count goes up. Each toggle increases the
count value by one.

f IMPORTANT: /f the number of contiguous '1' bits in the insert_multi_bit_rx_vector is set to less than 12,
then stat_chO_fec_corr_blocks count goes up since the FEC block is capable of correcting a burst of 11
error bits.

g. Intheinsert_*_bit_error_* VIO window,

- Toggle (0 > 1 > 0)insert_multi_bit_error_tx. This signal causes a burst of 12
errors on the transmit data.

- Verify the stat_chl_fec_uncorr_blocks count goes up. Each toggle increases the
count value by one.

h. In the Ethernet Controller application, click on Stop and verify Channel 0 MAC
statistics and Channel 1 MAC statistics for errors or packet drops. There will be errors
and the Frames Received count on the channels will not match up.

UG1058 (v2016.3) November 28, 2016 www.xilinx.com [—\/—]



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=41

i: XI LINX Chapter 3: Bringing Up the Design

ALL PROGRAMMABLE

To execute the sequence as described in step 8, a Tcl script is provided. Source the scriptin
the Tcl console of the Vivado IDE with the traffic running in the Ethernet Controller
application. The command to source the script is:

source
<working_dir>/kcul250_10gbasekr_trd/ready_to_test/fec_and_err_injection/err_in
jection.tcl

Dynamic Reconfiguration Ports

The GTH transceiver dynamic reconfiguration ports (DRP) can be accessed via the training
ports of the 10-Gigabit Ethernet PCS/PMA IP core. The training ports are brought out to
VIOs - training_*_ch0 and training_*_ch1.

1. For reads:

- Set the training_addr_ch* to a DRP address, example h' 00_007F
(TX_MARGIN_FULL_1, TX_MARGIN_FULL_0)

- Set the training_rnw_ch* to 1

- Toggle (0 > 1 > 0)enable_ch*

o The read value will be available on training_rd_data_reg_ch*
2. For writes:

- Set the training_addr_ch* to a DRP address example h'00_007F
(TX_MARGIN_FULL_1, TX_MARGIN_FULL_0)

o Set the training_wr_data for the above address as h'AE9C
o Set the training_rnw_ch* to 0
o Toggle (0 > 1 > 0)enable_ch*

- Read the value back following the instructions for Reads to verify that the write was
successful

To execute the sequence described in step 1 and step 2, A Tcl script is provided in:
<working_ dir>/kcul250_1l0gbasekr_trd/ready_to_test/drp_rd_wr.tcl
Source the script in the Tcl console of the Vivado IDE.

Refer to UltraScale Architecture GTH Transceivers User Guide (UG576) [Ref 15] for a list of
DRP addresses that can be accessed.
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Chapter 4

Implementing and Simulating the Design

<D

10GBASE-KR Ethernet TRD

This chapter describes how to implement and simulate the 10GBASE-KR TRD.

Implementing the Design

The 10GBASE-KR TRD is implemented using Vivado® Design Suite.

Download the Reference Design Files

See Download Targeted Reference Design Files, page 11 for instructions.

TIP: The Reference Design directory structure is described in Appendix A, Directory Structure.

IMPORTANT: The 10-Gigabit Ethernet MAC IP core (10G MAC) requires a license to build the design.
Obtain the license at the 10 Gigabit Ethernet Media Access Controller (10GEMAC) website [Ref 16].
Click Evaluate or Order to access the license.

IMPORTANT: The 10-Gigabit Ethernet PCS/PMA IP core (10GBASE-KR) requires a license to build the
design. Obtain the license at the 10 Gigabit Ethernet PCS/PMA with FEC/Auto-Negotiation
(10GBASE-KR) website [Ref 17]. Click Evaluate or Order to access the license.
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Generate the Hardware Bitstream

The reference design can be implemented or simulated on a Windows 7 or a Linux
computer. The computer should have Vivado Design Suite 2016.3 installed on it.

1. Launch the Vivado Integrated Design Environment (IDE) and set up the reference design
project.

« In Windows 7:
Click Start > All Programs > Xilinx Design Tools > Vivado 2016.3 > Vivado 2016.3.
a. In the Tcl console type:
cd <working_dir>/kcul250_1l0gbasekr_trd/hardware/vivado
source scripts/kcul250_10GBASEKR_trd.tcl

e On Linux:

a. On a terminal window, change the directory to:
<working_dir>/kcul250_1l0gbasekr_trd/hardware/vivado
b. At the command prompt enter:

vivado -source scripts/kcul250_10GBASEKR_trd.tcl
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The Vivado IDE will display the 10gbasekr_trd project populated with sources

(Figure 4-1).

directly under C: \.

IMPORTANT: When building the design on Windows, if this error occurs: Path Length Exceeds
260 Bytes maximum allowed by Windows, move the kcul250_10gbasekr_trd directory
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Figure 4-1:

2. Select the Sources tab.

10GBASE-KR TRD Design Hierarchy

UG1058_c4_01_092414

In the Hierarchy window, two IP Integrator (IPI) block designs are referenced

(Figure 4-2). Block design mac_phy.bd contains the 10-Gigabit Ethernet MAC IP core
(10G MACQ), 10-Gigabit Ethernet PCS/PMA IP core (LOGBASE-KR), the Traffic Generator
and Monitor, and the MicroBlaze™ processor subsystem. Block design

10GBASE-KR Ethernet TRD
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eyescan_sys.bd contains the JTAG to AXI Master IP core, AXI BRAM Controller IP
core, DRP to AXI bridge logic, and the MicroBlaze processor subsystem.

The design top level file kcul250_10gbasekr_top.v instantiates the block designs
The top level file also instantiates the VIO cores to configure and monitor the
10-Gigabit Ethernet PCS/PMA IP core.

e rd

File Edit Flow Tools Window Lawout Yiew Help
ACE ovRRB X 3P PN 6K LS Eoeaun e LS I Ready
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Figure 4-2: Vivado Project, Sources View

3. In the Flow Navigator, click Generate Bitstream.

4. In the No Implementation Results Available window, click Yes. The bitstream will be
generated and available at:
<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/impl_run/
10gbasekr_trd.runs/impl_1/kcul250_10gbasekr_top.bit.

O NOTE: /t takes about an hour to build the bitstream.
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Generate ELF File for the MicroBlaze Controller in mac_phy.bd

1. To generate the application (ELF file) to run on the MicroBlaze processor, the block
design must be exported and built in the SDK. To launch SDK with the mac_phy block
design exported, in the Tcl console type:

source scripts/launch_sdk_mac_phy.tcl (Figure 4-3).
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Figure 4-3: Export Hardware to the SDK
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2. In the SDK window (Figure 4-4) select File > New > Application Project to build an
application.

Chapter 4:

10

M I b
Xilinx Tools Window Help

- B

S| Eou 2. @Ma —0O|

| An outline is not available. |
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3. In the Application Project window (Figure 4-5) enter the project name as

kcul250_10gbasekr_top and click Next.

Application Project

Create a managed make application project. @

Project name: |kcu1250_1t}gbasekr_top| |

[ Use default location

Target Hardware

Hardware Platform: lkcu125G_mgbasekr_top_hw_p]an‘om_c ¢] |Ngw]
Processor: [ microblaze_sub_system_microblaze 0 > ]
Target Software

Language: AL OCHE

0S Platform: standalone ¢]

Board Support Package: ) Create New |kcul250 10gbasekr top bsp |

@ | [ mew> [ mmsh J[ cancel |
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Figure 4-5: Assign Project Name
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4. Select Empty Application and click Finish (Figure 4-6).

Templates

application project.

Available Templates:

Create one of the available templates to generate a fully-functioning

Peripheral Tests
Memory Tests

IwlP Echo Server
Dhrystone

SREC Bootloader

Zynqg FSBL

RSA Authentication App
Empty Application
Zyng DRAM tests
Xilkernel POSIX Threads Demo
Hello World

|a blank C project.

<Back || 1

| __Enish ||

Cancel

Figure 4-6:
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5. In the project explorer tab (Figure 4-7), right-click kcul1250_10gbasekr_top, select
Import, and under the General tab select File System. Click Next.

SO

C/C++ - keu1250 10gbasekr top bsp/system.mss - Xilinx SDK
File Edit Source Refactor MNavigate Search Project Xilinx Tools Bun Window Help

= | ® - &) - G2 EEEDE & @0 G B
<::| -
[ Project Explorer 2 | =1 |
& |y ~ Select \ Lt
&= Import resources from the local file system into an existing project. @
b =5 kcul250_10gbasekr_top _

P M kcul250_10gbasekr_top_bsp
= (& kcul250_10gbasekr_top_hw_platform_0 : .
{7 mac_phy_bd.tcl | H|
|3 system. hdf v & General
& Archive File
& Existing Projects into Workspace
| File System
El Preferences
P &= CiCH++
I = Install
P = Remote Systems
b = Run/Debug
b = Team

Select an import source:

(o]

|
(I I |>1{

44 Target Connections 2 =i 2

-4 Local [default] @ ||| Next > | | f | [ Cancel
b = Auto Discovered

Description

(] 111 ] (al 1l [»]

1= kcul250_10gbasekr_top
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Figure 4-7: Importing File System
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6. Browse to source folder:

Implementing and Simulating the Design

<working_dir>/kcul250_10gbasekr_trd/software/source.

Select the source directory in the left pane and click Finish (Figure 4-8).

The application ELF file will be generated and available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/impl_run/10gbasekr
_trd.sdk/mac_phy/kcul250_10gbasekr_top/Debug/kcul250_10gbasekr_top.elf.

| C/C++ - keu1250 10gbasekr_top bsp/system.mss - Xilinx SDK

‘Fﬁ 2\_ B %
P 15 kcul250_l0gbasekr_top
P il kcul250_10gbasekr top_bsp
~ @ kcul250_10gbasekr_top_hw_platform_0
{7 mac_phy_bd.tcl
[ system. hdf

= ®-& - & |a-g
EEY ® -
S -

File Edit Source Refactor MNavigate Search Run Project Xilinx Tools Window Help

File system

Import resources from the local file system.
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[1 (= source

[ [& CommandDesc.h
O T8 Iscript.ld

[ [¢ platform_config.h
O [{ platform.c

[ [ platform.h

O B README.txt

[ [g regaccess.c

= [EcicH|

T
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o 3 | =
=0u % @ Ma| g
Call, e s

An outline is not available.

|
)|

[H!ter}ypes‘.‘] [ Select All ] [ Deselect All ]
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Into folder: Ikcu1250_10gbasekr_top ] I Browse... ] P
Options =
[] Overwrite existing resources without warning > _}
[ Create top-level folder _‘
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Figure 4-8: Importing Software/Source Directory
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Generate ELF File for the MicroBlaze Controller in
eyescan_sys.bd

1. To generate the application (ELF file) to run on the MicroBlaze processor, the design
must be exported and built in the SDK. To launch SDK with eyescan_sys block design
exported, type:

source scripts/launch_sdk_eyescan.tcl

in the Tcl console (Figure 4-9).

File Edit Flow Tools Window Lawout Yiew Help
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o~ LI vio_cfg_chl - wio_cfg (vio_cfg.xci) = =]
4 RTL Analysis Hierarchy |F Sources Libraries Compile Order ﬁ
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ﬁ} Symthesis Settings
& Run Synthesis
> &% Open Synthesized Design
4 Implementation E
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i: Run Implementation e — e
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Figure 4-9: Launch the SDK
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Implementing and Simulating the Design

In the SDK window (Figure 4-10) select File > New > Application Project to build an
application.

'Ele | Edit Source Refactor Navigate Search Project Xilinx Tools Run Window Help
| New Shift+Alt+N » :@Application Project w = 4 -
Open File... E SPM Project :]
lif, Board Support Package &
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Class
4 4
% Other... Ctrl+N
e e T blaze_0
Convert Line Delimiters To b axi_bram_ctrl_0 0xc2000000 0xc2001E£E B
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Switch Workspace » 1b_bram_if_cntlr_0 0x00000000 0x00003££E
Restart b_bram_if_cntlr_0 0x00000000 0x00003£££
£23 Import present in the design
e Export ctrl_o axi_bram_ctrl ||
vl N e hils mnnm ~an e |
Properties Alt+Enter | [v]
1 system.hdf [kcul250_l0gbasekr_eyesc...]
T Bc Ep @7 = B [E|sDKLog & BE = O
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= ~ | 10:56:38 INFO  : Processing commanc
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Figure 4-10: Building an Application Project in the SDK
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3. In the Application Project window (Figure 4-11) enter the project name as
kcul250_10gbasekr_eyescan and click Next.

Application Project

Create a managed make application project. E?

Project name: |kcul250_l0gbasekr_eyescan| |

[] Use default location

Target Hardware

Hardware Platform: |kcu1250_10gba5akr_ayescan_hw_pla'b‘orm_o :l |N§w]

Processor: | mb_ps_microblaze_0 s

Target Software

Language: @LC OCc+Ht+

0S Platform: standalone :]
Board Support Package: (O Create New

kcul250_10gbasekr_eyescan_bsp |

Q (o> [Eman ] G
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Figure 4-11: Assigning a Project Name in the SDK
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4. Select Empty Application and click Finish (Figure 4-12).
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Templates

Create one of the available templates to generate a fully-functioning

application project.

Available Templates:

Peripheral Tests
Memory Tests

IwlP Echo Server
Dhrystone

SREC Bootloader

Zyng FSBL

RSA Authentication App
Empty Application

Zyng DRAM tests
Xilkernel POSIX Threads Demo
Hello World

A blank C project.

e |

Cancel

Figure 4-12:
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5. In the project explorer tab (Figure 4-13), right-click kcu1250_10gbasekr_eyescan,
select Import, and under the General tab select File System. Click Next.

S0k

C/C++ - kou1250_10gbasekr_eyescan_bsp/system.mss - Xilinx SDK

File Edit Source Refactor MNavigate Search Project Xilinx Tools Run Window Help
Fil ® -/ - B &3 - =
& ot
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- j I= s ) . . )
 Project Explorer 52 | B 2| ¥ Import resources from the local file system into an existing project. @ I
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b s kcul250_10gbasekr_eyescan_bsp Select an import source:
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D ¥ ;d: - (= General —
4 system.
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Figure 4-13: Importing File System
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6. Browse to source_eyescan folder:
<working_dir>/kcul250_10gbasekr_trd/software/source_eyescan
Select the source_eyescan directory in the left pane and click Finish (Figure 4-14).
The application ELF file will be generated and available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/vivado/runs/impl_run/l0gbasekr_t
rd.sdk/eyescan/kcul250_10gbasekr_eyescan/Debug/kcul250_10gbasekr_eyescan.elf

"I C/C++ - keu1250 10gbasekr_eyescan_bsp/system.mss - Xilinx SDK
File Edit Source Refactor Mavigate Search Pmoject Xilinx Tools Run Window Help
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[7 eyescan sys_bd.tcl L1 (= source_eyescan [ [g drp.c
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[ [¢ eyescan_main.c
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@
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Figure 4-14: Selecting the software/source Directory
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Generate Bitstream For Download

1. Create a bitst
command:

source SscCr

ream for download. In the Vivado Tcl Console (Figure 4-15) run the

ipts/create_download_bit.tcl

Ip Q- Search commands

File Edit Flow Tools Window Layout Yiew He
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Figure 4-15: Run Script to Create download.bit

The create_download_bit.tcl script runs the update_mem command and combines
kcul250_10gbasekr_top.bit, kcul250_1l0gbasekr_top.elf and
kcul250_10gbasekr_eyescan.elf into single BIT file available at:

<working_dir>/kcul250_1l0gbasekr_trd/hardware/vivado/runs/impl_run/
10gbasekr_trd.runs/impl_1/kcul250_10gbasekr_download.bit
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Simulating the Design

The 10GBASE-KR TRD can be simulated using the Vivado Design Suite simulator. The TRD
can also be simulated using Modelsim/Questa. Refer to Vivado Design Suite User Guide:
Logic Simulation (UG900) [Ref 18], for information describing how to run simulations with
different simulators.

The simulation environment sets up the Traffic Generator and Monitor blocks of the TRD.
The Traffic Generator for channel 0 generates 10 packets which are transmitted to the
10-Gigabit Ethernet MAC IP core. The packets are looped back on the PHY and become
receive packets on channel 1. Similarly, the Traffic Generator for channel 1 generates 10
packets which are transmitted to the 10-Gigabit Ethernet MAC IP core. The packets are
looped back on the PHY and become receive packets on Channel 0. The test bench waits to
receive the 10 packets on each channel without errors and then ends the simulation with a
Simulation Passed message. Simulating the AXI UART Lite IP and MicroBlaze processor
subsystem takes a lot of time. In order to speed up simulation the Traffic Generator and
Monitor block is not configured using its AXI4-Lite interface connected to the MicroBlaze
processor subsystem. The Traffic Generator and Monitor block provides a port tg_config to
configure the block. This port is used only for simulation. Table 4-1 shows the bitmap for
this port.

Table 4-1: Traffic Generator Configuration Port

Bit Position Description
0 Enable loopback for external generator mode.
1 Enable generator for internal generator mode.
31:16 Ethernet frame data payload size.
Allowed values (46 bytes to 1,500 bytes).

The test bench for the 10GBASE-KR TRD is available at:

<working_dir>/kcul250_10gbasekr_trd/hardware/sources/testbench/tb.v.

f IMPORTANT: Before running a simulation, the kcul250_10gbasekr_ref design project must be open
and step 1 under Generate the Hardware Bitstream must be executed.
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To run a simulation in Modelsim/Questa:

1. In the Flow Navigator, under Simulation, click Run Simulation > Run Behavioral
Simulation (Figure 4-16).
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Figure 4-16: Run ModelSim Simulation
To run a simulation using the Vivado Design Suite Simulator:

1. In the Flow Navigator, under Simulation, click Simulation Settings.
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2. In the Project Settings window (Figure 4-17), select Vivado Simulator in the Target
simulator field and click Yes when asked if it is OK to change your target simulator to

Chapter 4: Implementing and Simulating the Design

Vivado Simulator. click OK in the Project Settings window.
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Figure 4-17: Set Simulator to Vivado Simulator

3. In the Flow Navigator, under Simulation, click Simulation > Run Behavioral

Simulation.
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Chapter 5

Reference Design Details

This chapter describes the hardware design and software components.

Hardware

Figure 5-1 shows a block-level overview of the 10GBASE-KR TRD.
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Figure 5-1: 10GBASE-KR TRD Block Diagram

10GBASE-KR Ethernet TRD N Send Feedback 63
UG1058 (v2016.3) November 28, 2016 www.xilinx.com l—\/—l



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=63

i: XI LINX Chapter 5: Reference Design Details

ALL PROGRAMMABLE
The details of the hardware architecture are provided in three sections:

« Data Plane Components: Describes the 10-Gigabit Ethernet PCS/PMA IP core
(LOGBASE-KR), 10-Gigabit Ethernet MAC IP core (10G MAC) and the Traffic Generator
and Monitor.

« Control Plane Components: Describes the MicroBlaze™ processor subsystem and the
peripherals connected to it.

» Eye Scan System Components Describes the MicroBlaze processor subsystem and JTAG
to AXI Master IP core that communicate with the DRP port of the transceivers to collect
data samples and create an eye diagram.

+ Clocking and Reset: Describes how clocks and resets are distributed to the different
components in the 10GBASE-KR TRD.

Data Plane Components

The 10-Gigabit Ethernet PCS/PMA IP (10GBASE-KR) and 10-Gigabit Ethernet MAC IP (10G
MAC) cores constitute a 10 Gb/s Ethernet channel. There are two channels in the
10GBASE-KR TRD; channel 0 and channel 1. The data source for each channel is a Traffic
Generator implemented in the FPGA that drives the 10G Ethernet MAC.

10-Gigabit Ethernet PCS/PMA IP Core

The 10-Gigabit Ethernet PCS/PMA (10GBASE-KR) IP core provides an XGMII interface to
connect to a 10-Gigabit Ethernet MAC IP core and implements a 10.3125 Gb/s serial
single-channel PHY (GTH transceiver) brought out to TXN/TXP and RXN/RXP I/O pins that
are connected to differential SMA connector pairs on the board. SMA cables connect these
signals to the backplane.

The 10GBASE-KR IP core is configured to support auto negotiation (AN) and forward error
correction (FEC). The MDIO interface is disabled and configuration and status vectors are
used to manage the core.

A license can be obtained at the 10 Gigabit Ethernet PCS/PMA with FEC/Auto-Negotiation
(10GBASE-KR) website [Ref 17]. More information is available in the 10G Ethernet PCS/PMA
LogiCORE IP Product Guide (PG068) [Ref 19].

Relevant bits of the configuration and status vectors are brought out to Virtual
Input/Output (VIO) IP cores to configure and monitor the IP. The training port of the
10-Gigabit Ethernet PCS/PMA is also connected to a VIO IP core to access the transceiver's
DRP address map.

More VIO IP core information is available at the Virtual Input/Output (VIO) website [Ref 20]
and in the Virtual Input/Output LogiCORE IP Product Guide (PG159) [Ref 21]. Details about
the DRP address map is available in UltraScale Architecture GTH Transceivers User Guide
(UG576) [Ref 15].
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10-Gigabit Ethernet MAC IP Core

The 10-Gigabit Ethernet MAC (10G MAC) IP core is a single-speed, full-duplex, 10-Gb/s
Ethernet Media Access Controller. This 10G MAC connects to the PHY layer through the
XGMII interface. The internal Traffic Generator drives data on the AXI4-Stream ports of this
IP.

A license can be obtained at the 10 Gigabit Ethernet Media Access Controller (10GEMAC)
website [Ref 16]. More information is available the 210G Ethernet MAC LogiCORE IP Product
Guide (PG072) [Ref 22].

Traffic Generator and Monitor

Figure 5-2 shows the Traffic Generator and Monitor. The traffic generator block generates
Ethernet Traffic. The performance monitor block monitors the AXI4-Stream ports of the
10-Gigabit Ethernet MAC IP core and reports throughput.

The User Control and Status Register block passes information to and from the Ethernet
Controller application using the MicroBlaze processor subsystem.

Traffic Generator
PHY status »| User Control and Status AXI-Lite transactions to
» . and from the MicroBlaze
] Registers
Processor Subsystem
. AXl4-Stream TX traffic to
Generator (Internal) > e MAC
AX|4-Stream RX traffic Performance Monitor
from the MAC

UG1058_c5_02_070814

Figure 5-2: Traffic Generator and Monitor

Internal Traffic Generator, Generator Module

The internal Traffic Generator module generates Ethernet packets based on user inputs
provided from the Ethernet Controller application running on the control computer. Data
payload size can be from 46 bytes to 1,500 bytes. Table 5-1 shows the packet format
generated by the internal Traffic Generator module.

UG1058 (v2016.3) November 28, 2016 www.xilinx.com [—\/—]



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=65

& XILINX

Chapter 5: Reference Design Details
ALL PROGRAMMABLE
Table 5-1:  Packet Format of Generated Packets
Byte 7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0
Source Address Destination Address
Sequence Number Length Source Address
.................................... Sequence Number Sequence Number

Sequence Number

The source and destination MAC addresses are parameters into this block. The length field
is the data payload value. The actual length of a packet generated by this block is:

Data payload

14 bytes of header (Destination Address + Source Address + Length/Type Field) +

The sequence number field indicates packet count and increments by one every packet.

The generated packets are transmitted on AXI4-Stream interface to the 10-Gigabit Ethernet
MAC IP core. Table 5-2 shows the parameters and ports on the generator module.

Table 5-2: Generator Module Parameters and Ports

Port/Parameter Name Type Description
Source MAC Address

XIL_MAC_ID_THIS Parameter | For channel 0 = 48'h111100000000
For channel 1 = 48'1h222200000000
Destination MAC Address

XIL_MAC_ID_OTHER Parameter | For channel 0 = 48'h222200000000
For channel 1 = 48'h111100000000

Clock and Reset Ports

reset Input Synchronous reset.

tx_axis_clk Input 156.25 MHz clock transmit ports on the AXI4-Stream interface.

Transmit Ports on the AXI4-Stream Interface

tx_axis_tdata[63:0] Output Data to be transmitted to the 10-Gigabit Ethernet MAC IP core.
The transmit keep signal is used to determine which data bytes are valid
on tx_axis_tdata during a given beat (this signal is valid only if
tx_axis_tvalid and tx_axis_tready are both asserted).

tx_axis_tkeep[7:0] Bit O corresponds to the Ie’astl shlgnlflcant byte on tx_axis_tdata and bit 7
corresponds to the most significant byte.
When tx_axis_tlast is not asserted, the only valid value is 0xFF. When
tx_axis_tlast is asserted, valid values are 0x1, 0x3, 0x7, 0xf, O0x1f, Ox3f,
0x7f and Oxff.

tx_axis_tlast Output End offr'ame|r'1d|catoron transmit packets. Valid only along with assertion
of tx_axis_tvalid.

tx_axis_tvalid Output Source ready to provide transmit data. Indicates that the generator is

presenting valid data on tx_axis_tdata.
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Table 5-2: Generator Module Parameters and Ports (Cont’d)

Port/Parameter Name Type Description

tx_axis_tuser Output | If asserted indicates an underrun frame. This is tied to 1 'b0.
Destination ready for transmit. Indicates that the 10-Gigabit Ethernet

) MAC IP core is ready to accept data on tx_axis_tdata.

tx_axis_tready Input ) ] ) ; )
The simultaneous assertion of tx_axis_tvalid and tx_axis_tready marks the
successful transfer of one data beat on tx_axis_tdata.

Control Ports

enable_gen Input Enable internal generator.

data_payload Input Size of the payload (46 bytes to 1,500 Bytes).

The data flow with internal generator mode enabled on the Traffic Generator for channel 0

IS:

Generator module CHO — CHO TX AXI4-Stream interface of the 10-Gigabit Ethernet
MAC IP — CHO TX XGMII interface of the 10-Gigabit Ethernet PCS/PMA IP — CHO
TXN/TXP serial lines — loopback to CH1 RXN/RXP serial lines —» CH1 RX XGMII
interface of the 10-Gigabit Ethernet PCS/PMA — CH1 RX AXI4-Stream interface of the
10-Gigabit Ethernet MAC IP core

The data flow with internal generator mode enabled on Traffic Generator for channel 1 is:

Generator module CH1 — CH1 TX AXI4-Stream interface of the 10-Gigabit Ethernet
MAC IP — CH1 TX XGMII interface of the 10-Gigabit Ethernet PCS/PMA IP — CH1
TXN/TXP serial lines — loopback to CHO RXN/RXP serial lines —» CHO RX XGMII
interface of the 10-Gigabit Ethernet PCS/PMAIP — CHO RX AXI4-Stream interface of the
10-Gigabit Ethernet MAC IP core

Ethernet Performance Monitor

The Ethernet performance monitor block snoops for valid transactions on the AXI4-Stream
interface ports of the 10-Gigabit Ethernet MAC IP core and keeps track of bandwidth
utilization. A timer within this block counts the clocks until one second has elapsed, during
which time counters have collected data about link performance.

Four counters collect information on the transactions on the AXI4-Stream interface:

« TX Payload Byte Count. This counter counts bytes transferred when tx_tvalid and

10GBASE-KR Ethernet TRD

tx_tready signals are asserted between the Traffic Generator block and the 10G MAC. At
the end of the packet (tx_tlast) 14 bytes of header are subtracted from the count to get
payload count.

TX Packet Count. This counter counts the number of transmitted packets. The counter
increments when tx_tvalid and tx_tready and tx_tlast signal are asserted.

RX Payload Byte Count. This counter counts bytes transferred when rx_tvalid and
rx_tready signals are asserted between the Traffic Generator block and the 10G MAC. At
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the end of the packet (rx_tlast) 14 bytes of header are subtracted from the count to get
payload count.

« RX Packet Count. This counter counts the number of received packets. The counter
increments when rx_tvalid and rx_tready and rx_tlast signal are asserted.

The counts are truncated to a four-byte resolution, and the last two bits of the register
indicate the sampling period. The last two bits transition every second from 00 to 01 to 10
to 11. The software polls the performance registers every second. If the sampling bits are
the same as the previous read, then the software needs to discard the second read and try
again. When the one-second timer expires, the new byte counts are loaded into the
registers, overwriting the previous values. Table 5-3 shows the parameters and ports on this

module.

Table 5-3: Ethernet Performance Monitor Parameters and Ports

Port/Parameter Name Type Description

Defines the number of 156.25 MHz clock cycles equivalent to 1 sec.

ONE_SEC_CLOCK_COUNT | Parameter | ¢, it value is 32 'h9502F90.

Clock and Reset Ports

reset Input Synchronous reset.

clk Input 156.25 MHz clock.

Transmit Ports on the AXI4-Stream Interface

tx_axis_tdata[63:0] Input Data to be transmitted to the 10-Gigabit Ethernet MAC IP core.
The transmit keep signal is used to determine which data bytes are valid
on tx_axis_tdata during a given beat (this signal is valid only if
tx_axis_tvalid and tx_axis_tready are both asserted).
tx_axis_ tkeep[7:0] Bit O corresponds to the least significant byte on tx_axis_tdata and bit 7
- pL/: corresponds to the most significant byte. When tx_axis_tlast is not
asserted, the only valid value is 0xFF.
When tx_axis_tlast is asserted, valid values are 0x01, 0x03, 0x07, 0x0F,
0x1F, 0x3F,0x7F, and OXFF.
. End of frame indicator on transmit packets. Valid only along with
tx_axis_tlast Input . . .
assertion of tx_axis_tvalid.
. . Source ready to provide transmit data. Indicates that the generator is
tx_axis_tvalid Input . . .
presenting valid data on tx_axis_tdata.
tx_axis_tuser Input If asserted indicates an underrun frame. This is tied to 1'bO0.
Destination ready for transmit. Indicates that the 10-Gigabit Ethernet
. MAC IP core is ready to accept data on tx_axis_tdata.
tx_axis_tready Input

The simultaneous assertion of tx_axis_tvalid and tx_axis_tready marks the
successful transfer of one data beat on tx_axis_tdata.

Receive Ports on the AXI4-Stream Interface

rx_axis_tdata[63:0]

Input

Data received by the 10-Gigabit Ethernet MAC IP core.
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Table 5-3: Ethernet Performance Monitor Parameters and Ports (Cont’d)

Port/Parameter Name Type Description
The receive keep signal is used to determine which data bytes are valid

rx_axis_tkeep[7:0] on rx_axis_tdata during a given beat (this signal is valid only if
tx_axis_tvalid and tx_axis_tready are both asserted).

. End of frame indicator on received packets. Valid only along with

rx_axis_tlast Input . . .

asser-tion of rx_axis_tvalid.
. . Source ready to provide data. Indicates that the MAC is presenting valid

rx_axis_tvalid Input .
data on rx_axis_tdata.

rx_axis_tuser Input If asserted indicates a good packet is received.
Destination ready for receive. Indicates that the loopback is ready to
accept data on rx_axis_tdata.

i axis tread Outout The simultaneous assertion of rx_axis_tvalid and rx_axis_tready marks

- y P the successful transfer of one data beat on rx_axis_tdata.

The 10-Gigabit Ethernet MAC IP core doesn't look at this signal and
sends received data whenever available.

Performance Statistics Ports

tx_byte_count Output | Number of bytes transmitted in one second.

tx_pkt_count Output | Number of packets transmitted in one second.

rx_byte_count Output | Number of bytes received in one second.

rx_pkt_count Output | Number of packets received in one second.

User Control and Status Registers

The user selections made in the Ethernet controller application are passed to the Traffic
Generator and Monitor using this block. An AXI4-Lite interface is required for the
MicroBlaze processor subsystem to execute reads (status) and writes (control) to this block.
The AXI4-Lite IP Interface (IPIF) is instantiated in the design to read and write to a register
map file (see the AXI4-Lite IP Interface (IPIF) website [Ref 23].

Providing an AXI4-Lite slave interface provides the flexibility of using this module in other
designs. To reuse this block, the control and status signals into the register map must be
changed. Appendix C, User-Space Registers describes the registers implemented in the
Traffic Generator and Monitor block. Figure 5-3 shows the user register interface.

AXI-4 Lite transactions
to and from the
MicroBlaze Processor

AXl4-Lite to IPIF

_ Control: Internal traffic generator
" selection, payload size, etc.

Status and Control

Register Ma
d e Status: Performance, PHY

status, etc.

A

10GBASE-KR Ethernet TRD
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Figure 5-3: User Register Interface
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Control Plane Components

The Ethernet Controller application running on the control computer sends control
information and receives status to and from different components of the 10GBASE-KR TRD
using the MicroBlaze processor subsystem.

MicroBlaze Processor Subsystem and AXI Interconnect

The IP cores required to support the MicroBlaze processor and create a subsystem are:

I
t

MicroBlaze local memory
Processor system reset
MicroBlaze debug module

AXI Interrupt controller

n Vivado IP], adding the MicroBlaze IP core and running the connection automation creates
he MicroBlaze processor system shown in Figure 5-4.

microblaze_0_axi_intc

2 dps_axi

microblaze_0_xlconcat s_axi_aclk
axi_aresetn
In0[0:0] 0 e intemuptes (| f—
In1[0:0]
processor_clk
Concat processor_rst

AX|Interrupt Controller (Pre-Production)

Clk [

microblaze_0 miLrubIag_D_luLal_mumury
mdm_1 ) ||[<=INTERRUPT P T ||| =DLME
MeDERUC 0 |} {4 pesuc Mi 3. o R r {lj e
Debug_SYS_Rst| L—Clk ’Cm aze ] LME Clk
. M_AXI_DPdh|:
rst_Clk_100M R : MEB_Fist
Blazg Debug Module (MDM) (Pre-Profuctiop)

otowest sync_clk mhb_reset MicroBlaze (Pre-Production)

t_reset_in bus_struct_reset[{: ] p—
we_reset_in peripheral_rese([00]m
mb_debug_sys_rst  interconnect_aresetn [0:0] g——

m_locked peripherml_areset n[0:0]
Processor System Reset (Pre-Production)

S00_ACLK MO0 Ao 1
_ARESETH
woo_aclk | -alfb

MOO_ARESETH

AXl Interconnect (Pre-Production)

UG1058_c5_04_062314

Figure 5-4: IPI-Generated MicroBlaze Processor System

The AXI interconnect IP allows the MicroBlaze processor subsystem to communicate with

t

he AXI Interrupt controller IP using the AXI4 memory mapped interface.

The 10GBASE-KR TRD AXI interconnect IP is reconfigured to have six master ports instead
of one. The six master ports connect to six AXI slaves:

10GBASE-KR Ethernet TRD

AXI interrupt controller
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« AXI UART Lite which communicates with the Ethernet Controller application running on
the control computer

» Channel 0 - 10-Gigabit Ethernet MAC IP core
« The Traffic Generator and Monitor connected to channel 0
« Channel 1 - 10-Gigabit Ethernet MAC IP core

« The Traffic Generator and Monitor connected to channel 1

The AXI interconnect enables communication between the MicroBlaze processor subsystem
(Master) and six peripherals (Slaves).

The address range assigned to each peripheral is shown in Figure 5-5. The application
driver running on the MicroBlaze processor subsystem will use these addresses to map
read/write transactions from the Ethernet Controller application to the AXI UART Lite to the
MicroBlaze processor subsystem to other peripherals and back.

B Address Editor X &= Diagram X

Q Cell [ Interface Pin | Base Name | Offset Address | Range | High Address

e @-{F microblaze_sub_system/microblaze_0

=] b B3 Data (32 address bits - 40

= = 3xi_uanlite_0 S_AX] Feq 0A0BOO000 E4K ~ OxA0GOFFFF
= icroblaze_sub_system/microblaze_0_local_memoryfdimb_bram_if_cntlr SLME Mern Ox00000000 128K = Ox0001FFFF
= pth_axi_stream_gen_mon_0 s_axi reg Oxd AM0000 SE1,4 ~ OxdAAOFFFF
== gth_axi_stream_gen_mon_1 s_axi reg OxdAA10000 Sk ~ DxdAAIFFFF
= microblaze_sub_system/mdm_1 S_A] Feg QxTE200000 [ZL 18 ~ Ox7EZ0FFFF
= microblaze_sub_system/microblaze_O_axi_intc s_axi Feg Qx4 1200000 7L 18 + Oxd120FFFF
== mac_phy_chidften_gig_eth_mac_cho s_axi Feg 74 C00000 [ZL 18 ~ Ox74COFFFF
= mac_phy_chlften_gig_eth_mac_chl s_axi Feg Qx74C10000 [ZL18 « Ox74C1FFFF

p-E Instruction (22 address hits @ 40)
L «a microblaze_sub_systemfmicroblaze_0O_local_memoaryfilmb_bram_if_cntlr  SLME Mern Qx0OO000000 128K = OxOO01FFFF

Figure 5-5: Peripheral Address Map

For more details on the MicroBlaze processor core, see the MicroBlaze Soft Processor Core
website [Ref 24].

For more details on AXI Interconnect, see the AXI Interconnect website [Ref 25].

AXI UART Lite

The AXI UART Lite IP core provides the controller interface for asynchronous serial data
transfer. The Ethernet Controller application running on the control computer
communicates with this serial interface.

The AXI UART Lite IP core also connects to the MicroBlaze processor subsystem through the
AXlinterface and passes information to and from the Ethernet Controller application to the
different components of the design.

For more details on AXI UART Lite, see AXI UART Lite LogiCORE IP Product Guide (PG142)
[Ref 26] and the AXI UART Lite website [Ref 27].
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Eye Scan System Components

The eye scan system in this reference design is based on application note XAPP1198. Refer
to In-System Eye Scan of a PCl Express Link with Vivado IP Integrator and AXI4 Application
Note (XAPP1198) [Ref 14] for more information.

AXI DRP Bridge

The AXI DRP bridge receives AXI requests from an AXI master such as the MicroBlaze
processor subsystem. It converts AXI transactions to DRP registers accesses on the
transceiver and routes the result back to the AXI Master. One bridge is required for every
transceiver that performs an eye scan. This reference design has two instances of the AXI
DRP bridge to get eye scan plots on 10-Gigabit Ethernet Channel 0 and Channel 1.

There is also an AXI DRP MUX in the reference design. This allows multiplexing of DRP
accesses between the AXI DRP Bridge and the 10-Gigabit Ethernet PCS/PMA IP Core.

AXI Block RAM Controller

An AXI Slave IP core that allows access to local block RAM by AXI Master devices such as
MicroBlaze processor subsystem and JTAG to AXI Master IP core. The block RAM stores the
data read from the DRP port of the transceiver.

For more details on the AXI Block RAM Controller IP, see the AXI BRAM Controller website
[Ref 28].

JTAG to AXI Master

The JTAG to AXI Master IP core is a customizable core that can generate AXI transactions
and drive AXI signals internal to FPGA. The Vivado logic analyzer Tcl console running on the
control computer interacts with this core through the USB-to-JTAG port on the

KCU1250 board. (Refer to Vivado Design Suite User Guide: Programming and Debugging
(UG908) [Ref 29].) It retrieves data stored in AXI BRAM Controller and passes it to the
control computer.

For more details on the JTAG to AXI Master IP core, see the JTAG to AXI Master website
[Ref 30].

MicroBlaze Processor Subsystem

The MicroBlaze processor subsystem communicates to the transceiver DRP interface
through the AXI to DRP Bridge logic. The software running on the MicroBlaze processor is
derived from code described in Eye Scan with MicroBlaze Processor MCS Application Note
(XAPP743) [Ref 31]. The software running on the processor implements the Eye Scan
algorithm on the transceiver and stores the data in the AXI block RAM. When the block RAM
is filled with Eye Scan data, the JTAG to AXI IP core reads the data out of the block RAM.
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Then it stores the data on the control computer in a text file through the USB-JTAG
connection (U80) on the KCU1250 board.

For more details on the MicroBlaze processor core, see the MicroBlaze Soft Processor Core
website [Ref 24].

AXI Interconnect
The AXI interconnect allows multiple AXI masters (MicroBlaze processor subsystem and

JTAG to AXI Master) to communicate with multiple AXI slaves (AXI DRP Bridge and AXI
BRAM Controller). The address map for the AXI slaves is shown in Figure 5-6.

&= Diagram X B Address Editor X

Q, Cell | Slave Interface | Base Mame | Offset Address | Range | High Address

= §-1iF jtag_axi_0

e2a | | & ER Data (32 address hits : 40)

Ié‘d == axi_bram_ctrl_0 S_AX] Memo QxC2000000 =18 ~ OxC2001FFF
—m drp_bridge_0 A regQ D CO00C000 L1 » QHCOO00FFF
—m drp_bridge_1 A regQ Dy CO00 1000 L1 v QHCOO01FFF

{F mb_ps,/microblaze_0
B Data (32 address bits @ 40)

e axi_bram_ctrl_0 5| Memo O C2000000 =1 > QOHC2O01FFF
e drp_bridge_0 vl regQ Cx 0000000 4K » QxCOOQOFFF
e drp_hridge_1 AX regQ QxCO001000 18 » OxCOO01FFF
o mib_psfimb_bram_if_cntlr_o SLMB Mem QxOO000000 1K v QOO0 3IFFF
B Instruction (22 address hits | 400}

L mbi_psflmb _bram_if_crtlr_0 SLME1L Merm (000000 16k > QxOOO03IFFF

UG1058_c5_315_092414

Figure 5-6: AXI Slaves Address Map in the Eye Scan System

For more details on the AXI Interconnect, see the AXI Interconnect website [Ref 25].

Clocking and Reset

The 10-Gigabit Ethernet PCS/PMA core requires a 156.25 MHz differential reference clock
for the GTH transceivers. The shared logic (clocking and reset logic) within the channel 0

10-Gigabit Ethernet PCS/PMA IP core produces a single ended 156.25 MHz clock. This clock
is used by the 10-Gigabit Ethernet MAC and Traffic generator on Channel 0. A similar clock
circuit is implemented for Channel 1. The MicroBlaze processor subsystem is driven by the
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channel 0 156.25 MHz clock. The single ended 156.25 MHz clocks from both channels are
routed to the eye scan system. Figure 5-7 shows the clock distribution.

156.25 MHz 156.25 MHz
Differential Clock Differential Clock

156.25 MHz CHO 156.25 MHz CH1

Y y Y Y A\
MicroBlaze ) CH1
Subsytem and CHO Traffic CHO MAC CHO PHY | | CH1 PHY CH1 MAC Traffic AXI
Gen-Mon UARTLITE
AXI Interconnect Gen-Mon

. A A A A A
g Im Im Im Im IuJ
; 2 2 g e 2
& |(:' |;' Eyescan |;' |;' |;'
% = = »| System [+ 2 2 2
N

UG1058_c5_06_002014

Figure 5-7: Clock Distribution

An external reset (a debounced DIP switch) drives the channel 0 10-Gigabit Ethernet
PCS/PMA IP core, the 10-Gigabit Ethernet MAC IP core and the Processor System Reset IP
core in the processor system. This reset also drives the eye scan system.

Another external reset dip switch drives the Channel 1 10-Gigabit Ethernet PCS/PMA IP
core, the 10-Gigabit Ethernet MAC IP core and the Traffic Generator and Monitor block.

The Processor System Reset Module IP core provides resets for the MicroBlaze processor
subsystem components and resets to the AXI Interconnect and peripherals (AXI4-Lite
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interfaces on AXI UART Lite, Traffic Generator and Monitor, and 10-Gigabit Ethernet MAC
IP). Figure 5-8 shows the reset connections.

reset_ch1_n
DIP Switch | | Debouncer | reset ch1
Reset Logic
Eyescan & @ =
System Iy D o
e » ©
DIP Switch | | Debouncer | _reset chO o o 3
Reset Logic o o} @
5 > S5
CHO CH1
cro | oo | [ e || ooy || s || e
Gen-Mon Gen-Mon
(7] (7] (7] (7]
s s s s
@ @ @ I
1) [} (2] [2}
o o @ o
= > > >
|> reset_ chO_n |
%
|
@
Reset to AX14 Stream Interface
—— Reset to MAC and PHY peripheral_aresetn
Processor |
Reset to AXI Lite Interfaces System interconnect_aresetn \: |: \;
Reset | bus_struct_reset ‘5- lé- ‘E-
Q 9 L
mb_reset o o 2
jed el e
A Y \ > S S
MicroBlaze | | MicroBlaze AXI AXI AXI UART
Local Int t
Processor Interconnect nterrup Lite
memory Controller
A

UG1058_c5_07_092014

Figure 5-8: Resets
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Software

There are two major software components to monitor and control the Ethernet Reference
Design System:

» GUI/Client Application

« MicroBlaze Processor Server Application

Figure 5-9 shows these components.

GUI/Client Application Server Application

UART Interface

Control Computer Microblaze Processor on KCU1250 Board

UG1058_c5_08_101614

Figure 5-9: Software Components

GUI/Client Application

A Java-based GUI/Client application running on the control computer communicates with
the MicroBlaze Processor Server Application through a UART interface to control test
parameters, collect statistics, and display current status of the design.

The GUI displays the following information:

« Current mode of operation

« Payload size

« Throughput numbers and graphs when a test is executing
» 10-Gigabit Ethernet MAC IP statistics

« Power consumption and temperature for the FPGA

« Block diagram of the design
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Figure 5-10 shows the GUL

KUCon-TRDOS 10GBASE-KR Ethernet Targeted Reference Design

® ETHOPHY ® ETH1PHY

—
Performance Piots |(Channel 0 Siatisics || Chiannel 1 Siatisiics |

Channel 0 Channel 1

Control Panel Control Panel

Tx Statistics Rx Statistics Tx Statistics Rx Statistics
Throughput (Gi ). 97 Throughput (Gbps) 974 Throughput (Gbps): a7 Throughput (Gbps):

Packet Count ] Packet Count 811316 Packst Count Packet Count

[m Tx Thioughput ® Rx Thioughput [m Tx Thioughput ® Rx Thioughput

UG1058_c5_09_061014

Figure 5-10: GUI (Ethernet Controller Application)
The GUI provides control of:

« Test mode: Select use of the internal traffic generator to generate Ethernet traffic.

« Payload size: Specify the size of packets when running in internal generator mode.

The GUI interacts with the KCU1250 board through the UART COM port exposed by the
Silicon Labs UART driver. All transmitted and received data adheres to a custom command
model followed by the client and server.

Command Format

The command format used by the GUI for reading and writing 32-bit values to the registers
in the design is described in this section.

Read Command

R <type of request> <output type> <Command number, denoted as a
4-character hexadecimal numeric string, AAAA>

« R denotes a Read command

10GBASE-KR Ethernet TRD N Send Feedback 77
UG1058 (v2016.3) November 28, 2016 www.xilinx.com l—\/—l



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=77

i: XI LINX Chapter 5: Reference Design Details

ALL PROGRAMMABLE

« type of request indicates the type of request and it can either be:
- s which specifies a single register read request, or

- b which specifies a bulk read request

Use a single register read for debugging purposes or for reading registers which are not
monitored by the GUL

Use a bulk read command to make the GUI constantly poll all test parameters and statistics.
This eliminates the need to send multiple commands for each individual value. A bulk read
command reads the registers in a predefined order.

+ output type indicates output type and it can be:
- h specifies the value sent out by the server will be the actual data width i.e., 4 bytes
- a specifies the value sent out by the server will be an 8-byte hexadecimal string

« AAAA denotes four character hexadecimal numeric string representation of the
command number which will eventually be mapped to the actual register offset in the
server application. Using different command numbers instead of the actual register
values allows the GUI to remain constant in spite of changes in the hardware design or
the application.

Example Read command:

R s a 0001: Read a single register corresponding to command number 0001 and the
reported value from the server should be in 8-byte hexadecimal format.

Read command response:

1. The command number is read by the server and the appropriate register is identified, its
value is read, and is stored in a 4-byte data value.

2. Based on the output type specified in the read command, the data is either directly
transmitted to the client by the server, or it is converted to an 8-character string
denoting an 8-character hexadecimal number and then sent out to the client on the
control computer side.

Currently the application only supports output type of 8-character hexadecimal string.
An example Read command output response: FO00000F.
Write Command

W <Command Number denoted as a 4-character hexadecimal numeric string
AAAA> < Data, represented as an 8-character hexadecimal numeric
string DDDDDDDD>

« W denotes a Write command
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« AAAA denotes a 4-character hexadecimal string representation of the command
number which will eventually be mapped to the actual register offset in the server
application.

+ DDDDDDDD denotes an 8-character hexadecimal string.
Example Write command:

e W 0001 007D0002: Write a value of 007D0002 to the register corresponding to
command value 0001.

Write command is always targeted towards a single register.

The mapping of command numbers to the corresponding register values is the same for
both Read and Write commands, i.e., if a write command with a certain command number
is used to update a register value, the same command number can be used with a read
command to retrieve the value.

MicroBlaze Processor Server Application

MicroBlaze Processor Server application running on the FPGA takes care of interpreting the
read and write commands sent from the client application, and acts accordingly. The
software layers are as shown in Figure 5-11.

Register Offset
Executer Identification for the Executer —
- . 1
A 2
3
Form Response
and Send to Client on Host Side 4
5
Command |_A ‘ > 5
Interpreter 7
Command Number
A to Array Index Mapping 8
9
10
Y —
UART Driver Integer Array
Containing All
Register Offsets

UG1058_c5_10_062714

Figure 5-11: Software Layers in the MicroBlaze Processor Server Application
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When the hardware platform is exported to the Software Development Kit (SDK) as
described in Generate ELF File for the MicroBlaze Controller in mac_phy.bd, page 47:

« The drivers for standard peripherals (like UART, Interrupt controller, etc.) that are
connected to the MicroBlaze processor are already available in the SDK.

« The base address of each peripheral assigned in the hardware platform as shown in
Figure 5-5 and is also accessible by the SDK.

The register offsets required by the server application to access relevant registers (TRD
configuration registers, performance registers, MAC Statistics, etc.) are available in the 10G
Ethernet MAC LogiCORE IP Product Guide (PG072) [Ref 22] and the user space registers as
described in Appendix C, User-Space Registers.

The UART driver is responsible for transferring and receiving data from the UART interface.
The server application uses the Application Programming Interface (API) provided by the
UART driver and communicates with the client application running on the control computer.
The main task of the server is to read/write values from/to the registers specified in the
READ/WRITE commands issued by the GUI.

The various steps undertaken by the server in servicing requests from the client are:

1. Register offsets to access registers are put in an integer array during the initialization of
MicroBlaze processor server application. The value placed in the integer array is:

- Base address for the component + register offset

2. The order in which these register offset values are placed is made aware to the client
application on the host side.

3. Each register is identified using a uniqgue command number. This command number is
same for both read and write commands.

4. When a client initiates a Read/Write command, the data is obtained by the server
application through the UART driver.

5. The Command Interpreter part of the server application then interprets the data
obtained from UART.

6. The Command Interpreter identifies the register offset value in the integer array, with
respect to the command number associated with the request.

7. The Command Interpreter functionality is different for Single Read and Bulk Read
commands.
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8. For asingle read request, command number shall give the index of the integer array
where the referenced register offset is placed.

Example Single Read Command:
R s a 0001

Here the command number is translated to 1 and the offset value of the register being
requested is placed in the zero index of the array.

9. Forabulk read request the command number represents a set of registers with a clearly
defined start and end index positions in the array.

Example Bulk Read Command:
R b a 0001

Here the command number 1 represents a set of register offsets in the array, 2 to 17. The
values placed at these array indices are the Ethernet performance registers for Channel
0 and Channel 1.

10. The Executor part of the server application then initiates either AXI Read/Write request
to the register offset values identified.

11. The Executor then sends an appropriate response to the client on control computer
through the UART driver.

NOTE: The bulk Read commands from GUI are serviced by the Server application by going through all

O the registers associated with the command in a predefined order and transferring the data with a "'
(white space) as delimiter between each register's value. This mode greatly reduces the number of
commands the GUI has to send to obtain the same amount of information.

The source code for the MicroBlaze application is available under the software/source
directory (see Appendix A, Directory Structure). The command mapping is defined in
CommandDesc. h.

NOTE: The software components for generating eye scans are described in Eye Scan with MicroBlaze

O Processor MCS Application Note (XAPP743) [Ref 31] and In-System Eye Scan of a PCl Express Link with
Vivado IP Integrator and AX14 Application Note (XAPP1198) [Ref 14] and are not covered in this
document.
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Appendix A

Directory Structure

The directory structures for the 10GBASE-KR TRD is shown in Figure A-1.

uc1250_10gbasekr_trd

software hardware ready_to_test readme
source sources
GUI hdl
ip_packaged
ip

constraints

testbench

vivado

scripts

UG1058_Aa_01_032515

Figure A-1: Targeted Reference Design Directory Structure
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Appendix A:

Directory Structure

Directory Content Summary

The files and folders contained in the 10GBASE-KR TRD are described in Table A-1. The
top-level folder is kcul250_10gbasekr_trd.

Table A-1: Directory Content
Folder Description
software Contains the software design deliverables.
source Contains the source code files used for creating the ELF file application that runs
on the MicroBlaze™ processor and communicates with the GUL
GUI Contains the EXE file used to install the Ethernet Controller GUL
hardware Contains all the required sources needed to generate a bitstream.
sources Contains subfolders that contain HDL files, custom IP that is packaged, VIO IP files,
constraint files, and test bench files.
hdl Contains HDL files.
ip_packaged | Contains custom IP that is packaged.
ip Contains VIO IP files.

constraints

Contains constraint files.

testbench Contains test bench files.

vivado Contains files to create a Vivado® Design Suite project and outputs of vivado runs.
scripts Contains Tcl scripts to create a Vivado project.
runs Created when the Tcl script file is sourced. The runs folder contains the output of

simulation, synthesis and implementation processes.

ready_to_test

Contains the bit file to program the KCU1250 characterization board.

readme

A TXT file that describes the 10GBASE-KR TRD and includes revision history
information.
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Performance Estimates

Appendix B

The 10-Gigabit Ethernet MAC IP core operates at a clock rate of 156.25 MHz using a 64-bit
data-path width (64 x 156.25 x 10® = 10 Gb/s).

For the XGMII, the minimum required interframe gap is 12 bytes. Header overhead consists
of a preamble (7 bytes) + Start of frame delimiter (1 byte) + MAC destination address (6

bytes) + MAC source address (6 bytes) + Length/Type field (2 bytes) + FCS (4 bytes). This
gives a total overhead of 38 bytes per Ethernet packet.

Table B-1 shows the effective throughput and percentage of maximum bandwidth used for

four different payload sizes.

Table B-1: Effective Throughput as a Function of Payload

Ethernet Payload Size Percentage of Bandwidth = Effective Throughput
(Bytes) Payload size/Packet size * 100 (Gb/s)
64 64/(38 + 64) = 62.7% 6.27
512 512/(38 + 512) = 93.1% 9.31
1024 1024/(38 + 1024) = 96.3% 9.63
1500 1500/(38 + 1500) = 97.5% 9.75
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Appendix C

User-Space Registers

User space registers are user-defined registers implemented in the Traffic Generator and
Monitor block shown in Figure 5-1. These registers can be accessed by the MicroBlaze™
processor subsystem via the AXI4-Lite interface.

Table C-1 through Table C-14 describe the custom registers implemented in the
10GBASE-KR TRD. All registers are 32 bits wide. Register bit positions are to be read from bit
31 to bit 0 from left to right. All bits that are undefined in this section are reserved and will
return zero when read. Address holes will also return a value of zero when read.

Each peripheral connected to the MicroBlaze processor subsystem is assigned an offset
address which is the base address for that peripheral. Figure 5-5 shows the addresses
assigned to the Traffic Generator and Monitor blocks (eth_axi_stream_gen_mon_0 and
eth_axi_stream_gen_mon_1). The Traffic Generator and Monitor base addresses are:

« Traffic Generator and Monitor channel 0: 0x42A0_0000

» Traffic Generator and Monitor channel 1: 0x4221 0000

Control and Status Registers

Traffic Generator—Monitor Channel 0

Table C-1: Design Version Register (0x4AA0_0000)

Bit Position Mode Default Value Description
3:0 4'h2 Ethernet reference design 2.
Indicates the Vivado® Design Suite version used when
15:4 Read Only 12'h141 developing this reference design. For example, Vivado Design
Suite 2014.1 is indicated by 141.
31:16 16'h1250 | Target Board: KCU1250 board.

10GBASE-KR Ethernet TRD
UG1058 (v2016.3) November 28, 2016

o l Send Feedback I 85
www.Xilinx.com



https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1058&Title=KCU1250%2010GBASE-KR%20Ethernet%20TRD%20User%20Guide,%20KUCon-TRD05&releaseVersion=2016.3&docPage=85

& XILINX

ALL PROGRAMMABLE

Appendix C:

Table C-2: Ethernet Performance Monitor, Transmit Payload Byte Count Register (0x4AA0_0004)
Bit Position Mode Default Value Description
1.0 00 Sample count. Increments once every second.
Transmit payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (tx_axis_tready = 1 and
’ tx_axis_tvalid = 1) on channel 0 10G Ethernet MAC AXI4-Stream
interface for transmit.
Table C-3: Ethernet Performance Monitor, Transmit Packet Count Register (0x4AA0_0008)
Bit Position Mode Default Value Description
1.0 00 Sample count. Increments once every second.
Transmit packet count. This field contains the count for the
312 Read Only 0 event when there is an active beat on channel 0 10G Ethernet
’ MAC AXI4-Stream interface and end of packet (tx_axis_tlast) is
asserted for transmit.
Table C-4: Ethernet Performance Monitor, Received Payload Byte Count Register (0x4AA0_000C)
Bit Position Mode Default Value Description
1.0 00 Sample count. Increments once every second.
Receive payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (rx_axis_tready = 1 and
’ rx_axis_tvalid = 1) on channel 0 10G Ethernet MAC AXI4-Stream
interface for receive.
Table C-5: Ethernet Performance Monitor, Received Packet Count Register (0x4AA0_0010)
Bit Position Mode Default Value Description
1.0 00 Sample count. Increments once every second.
Receive packet count. This field contains the count for the event
312 Read Only 0 when there is an active beat on channel 0 10G Ethernet MAC

AXI4-Stream interface and end of packet (rx_axis_tlast) is
asserted for receive.

Table C-6: Traffic Generator Configuration Register (0x4AA0_0014)

Bit Position Mode Default Value Description
0 0 Reserved.
1 Read or Write 0 Enable generator if internal generator is selected.
31:16 4'125 Ethernet frame data payload size. Allowed values (46 bytes to
1,500 bytes).
Table C-7: PHY status Register (0x4AA0_00x18)
Bit Position Mode Default Value Description
0 Read Only 0 PHY is up.
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Traffic Generator—Monitor Channel 1

Table C-8: Design Version Register (0x4AA1_0000)

Bit Position Mode Default Value Description
4:0 4'h2 Ethernet reference design 2.
Software version: Indicates the Vivado® Design Suite version
14:5 Read Only 12'h141 used when developing this reference design. For example,
Vivado Design Suite 2014.1 is indicated by 141.
31:16 16'h1250 | Target Board. KCU1250 board.

Table C-9: Ethernet Performance Monitor, Transmit Payload Byte Count Register (0x4AA1_0004)

Bit Position Mode Default Value Description

1:0 00 Sample count. Increments once every second.

Transmit payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (tx_axis_tready = 1 and

’ tx_axis_tvalid = 1) on channel 1 10G Ethernet MAC AXI4-Stream
interface for transmit.

Table C-10: Ethernet Performance Monitor, Transmit Packet Count Register (0x4AA1_0008)

Bit Position Mode Default Value Description

1.0 00 Sample count. Increments once every second.

Transmit packet count. This field contains the count for the
312 Read Only 0 event when there is an active beat on channel 1 10G Ethernet

’ MAC AXI4-Stream interface and end of packet (tx_axis_tlast) is
asserted for transmit.

Table C-11: Ethernet Performance Monitor, Received Payload Byte Count Register (0x4AA1_000C)

Bit Position Mode Default Value Description

1:0 00 Sample count. Increments once every second.

Receive payload byte count. This field contains the interface
312 Read Only 0 utilization count for active beats (rx_axis_tready = 1 and

’ rx_axis_tvalid = 1) on channel 1 - 10G Ethernet MAC
AXI4-Stream interface for receive.

Table C-12: Ethernet Performance Monitor, Received Packet Count Register (0x4AA1_0010)

Bit Position Mode Default Value Description

1.0 00 Sample count. Increments once every second.

Receive packet count. This field contains the count for the event
312 Read Only 0 when there is an active beat on channel 1 10G Ethernet MAC

’ AXI4-Stream interface and end of packet (rx_axis_tlast) is
asserted for receive.
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Table C-13: Traffic Generator Configuration Register (0x4AA1_0014)

Bit Position Mode Default Value Description
0 0 Reserved.
1 Read or Write 0 Enable generator if internal generator is selected.
31:16 41125 Ethernet frame. Data payload size allowed values = 46 bytes to
1,500 bytes.
Table C-14: status Register (0x4AA1_00x18)
Bit Position Mode Default Value Description
0 Read Only 0 PHY is up.
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Appendix D

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

References

The most up-to-date information for this design is available on these websites:

KCU1250 Characterization Kit

KCU1250 Characterization Kit Documentation

KCU1250 Characterization Kit Master Answer Record (AR 63058)

These documents and sites provide supplemental material:

1. IEEE Std 802.3-2012
IEEE Standard for Ethernet (includes specifications for 10GBASE-KR and 10GBASE-R)

2. KCU1250 Characterization Kit website

3. Tyco Electronics website
Z-Pack TinMan Customer System Kit User's Guide (backplane)

4. Samtec Bulls Eye cables website

5. Aeroflex/Inmet website: SMA DC Blocks
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Silicon Labs CP210x USB to UART Bridge VCP Drivers

Tera Term Home Page: Tera Term Pro terminal emulator software

6.
7.
8. Vivado Design Suite User Guide Release Notes, Installation, and Licensing (UG973)
9. Silicon Labs CP210x USB-to-UART Installation Guide (UG1033)

10. Tera Term Terminal Emulator Installation Guide (UG1036)

11. Oracle Java SE Runtime Environment 7

12. KCU1250 Characterization Board Schematics (XTP398)

13. HW-CLK-101-SCLK2 SuperClock-2 Module User Guide (UG770)

14. In-System Eye Scan of a PCl Express Link with Vivado IP Integrator and AXI4 Application
Note (XAPP1198)

15. UltraScale Architecture GTH Transceivers User Guide (UG576)

16. 10 Gigabit Ethernet Media Access Controller (L0GEMAC) website

17. 10 Gigabit Ethernet PCS/PMA with FEC/Auto-Negotiation (10GBASE-KR) website
18. Vivado Design Suite User Guide: Logic Simulation (UG900)

19. 10G Ethernet PCS/PMA LogiCORE IP Product Guide (PG068)

20. Virtual Input/Output (VIO) website

21. Virtual Input/Output LogiCORE IP Product Guide (PG159)

22.10G Ethernet MAC LogiCORE IP Product Guide (PG072)

23. AXI4-Lite IP Interface (IPIF) website

24. MicroBlaze Soft Processor Core website

25. AXI Interconnect website

26. AXI UART Lite LogiCORE IP Product Guide (PG142)
27. AXI UART Lite website

28. AXI BRAM Controller website

29. Vivado Design Suite User Guide: Programming and Debugging (UG908)
30. JTAG to AXI Master website

31. Eye Scan with MicroBlaze Processor MCS Application Note (XAPP743)
32. UltraScale Architecture System Monitor User Guide (UG580)

33. AXlI4-Lite IPIF LogiCORE IP Product Guide (PG155

34. System Management Wizard LogiCORE IP Product Guide (PG185)
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Training Resources

35. Vivado Design Suite Hands-on Introductory Workshop

36. Vivado Design Suite Tool Flow

Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials") is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to
Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical
applications, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.

© Copyright 2014-2016 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zyng, and other designated
brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of
their respective owners.
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